I3 1LdVIO

o

5 Al mIE AR LRI it

o7 i % VHDL 2 5 % 31 58 BUS - 26 20 R EDA S0 v 19 25
B IE LA B 0 LA RN g AR A A T LR A A N A A BN R 2, A
B A I35 1F #F FPGA I 58 BB 4 52 30 I g 2F 47 68 4 M 3L . 78 EDA
T HM BB o A 2 Fh ik 420k 58 % B b L R G0 0 2238 A D7
3, W HDL 4 A 4 A 7 20 L J5 B 1 i A 3 CIRAS B A XL B
i A J7 3 Matlab (9 #5845 A J7 =0, DLRCIR & 8 A D7 0. AR TG TR AR
AR Quartus [ F1 FPGA S250 65 #E47 2 48 L B 3% 1 19 S5 30 07 15
R, ARFRTE T — Lo A] g R B R Bl ST 38 S S50 W] DLTE 4 M
#&8 FPGA JF & i 2 . %48 Quartus [I #K4FHl GWA4S-CP++ 5250 & By fff
5 %2 VHDL A B ]y vk 3% T 12 48 v i, 2248 2 WAk ik
W 4 M BR R AR T o AR T 1 S 00 0 R A R TR A T R A B Y
BB AT AR T A S0 L R AR L R R S S
Rl

3.1 IR SR S5
3.1.1 33E FPGA BB FF £ 3R 15

1. LI E/W

(1) #4K Quartus [ FF RS R LR,
(2) %42 Quartus [ " VHDL SCARK AT .
(3) BW& FPGA 256 & W ShRE AN H 7 2 .

2. IXAR

FIAH Quartus T SE A% 2 #% 1 %%L?*%%E’thzl&ﬁiﬂiﬁufwmuxﬂa
vhd) FF EIR AL A 2 3 1 S8BT EIE . &5 ELE
R AT AR, B 2 Bk 1 2 EK R RS A T BE



was @zmzﬁyk;umw 103

3. KWIRE

PC 1&
Quartus I #4353 1E
GWA48-CP++ 52 & 14

4. KRB 5B

ARG A VHDL 31 2 € 1 2 Bk £ 4 0 B% 7 28 1R T 28 181 43 501 O 2. 1 75 19
&l 2-1 F0l&l 2-2, BAHER W 2.1 99 3R 2-8, FIH] Quartus [l 3¢t 2 & 1 2Bk £ s 2L
PR A 3-1 FiR,
L2k 1 Z PR ERRAR Y B R R 2-8 s, k] VHDL i 5
Wit 2wk 1 2Rtk gy, VHDL AU 2 00 2. 1 35 P g7 P2-1,

(2) wiFRiic e . FEEME RS e, I E L8 6
i FPGA B R #15, GWAS-CP++ 3 & E . i 5k
EP3C40Q240 , 7E £ 3. T2 B 7] LA 48 5 ot v A5, o AT DUAE 2 37
T ARG E32 8 Assignment—Device % &,

(3) i iF. J22S0 B2 4 B B HE B L 58 UL B A0 2R 5 A
Jay ARERAE T AR AES 12 i A2 b nl DU A P A L R R W

G P AIBC B

TEFIIIA

LA A e G )

(4) {5 L. 58 Rox o B i 2 A8 I3 Ja 5 2 S R SO i
HL I B A 52 as AT D7 EOUL S I 1 a1 45 R L R A R B ) 02
PRARDIRE R LG . FEAOCH RO LA M B A B3l 238 1 SHIREE

= AR L T L IR LM U A S ML O B L R A ERBUHTR
L 38 B Bh e ST TR b A MR A SR
HES (1 25 14 B30 (4 56 VE 07 EL OB T S A/ 1 13 5 0 (B2 75 TE . 0 20 10 B ) T LA AR 4

S i K DA K HL B T BE 1 O e TR0 L TR BRI R ) DL R R Y 4 LI ] L B ]
56 T BB R DI RE . p EL T E) A 5 T GE ) E 3R Edit>End Time SR E ., — B E
s B GOR AT LUl R 2K

(5) e MM E . Quartus I ¥ HL LIS » F K A Ja A 42 1 H i 22 58 5 T F 5 |
JIEN T 2 6 Sy 2 P 8 T S R RIS BRI A 0 HR B B Programmer X 42 SC {4 (. poD) 3 SRAM X}
GO Cosol) o 78 AR B B2 R 2 1 220k B 8% B S A 5 24T 5 IR 43 TC . BP0 F % 1Y B
NN/ G55 FPGA L5 IAEE . DA 5 S2R) FH 5256 65 00 4% B R 508D A8 45 SMBE XoF
LB AT I . SR Bi e RS g & M FH ik WL 2.3, 5 75

(6) F AL, W Sof U5 . JA 3 4% #2 #% Programmer, ¥ % ByteBlasterMV
[Lptl 4 07 R GFREALS SE8 R LPT Bdls 48 i H2) . S8 J5 T LUK WL B Y Sof SCHF R
H P L AR FPGA B b, FRZATT ZAOESE R & 5t Ayl 2 s &k 4,0 B
S £ R O A TIF . ARG AT LR 52 00 A3 Y Fe S RRCTD 45 45 51 5 XY o B i 17
it
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5. XIREZSTE

1) ST T AR FE SO R 81 1 S

e TAEIE B 5%, DB A6 TR H B F Sk, AR AT — 30038 3 #F & — 51 T f2
(Project) , #R WA A0 17 516 Ay b TR N7 — 4N il 5 b TR R DG 09 BT A 1R T ST Se i e it
S e B EDA SR AEBRIACH TAEFE (Work Library) . — 3 18 . R [6) 1935 1300 B 5 b ik 78
AN TRY 8 SO e v i ) — TR 0 T A SO 30 A 00 TR — SCHF e b o 3 AN BN SO e i
FEVFENLE A W23 H S AN Z0M TR SO e e H kb, fEEEN T S0 )5
BE T LB SOl i Quartas [T A9 SCAS 4 48 4% 4 48 O A7 45 TRANE TR AN T .

(1) Bt — e F e 545 B 30 g — A OB e, n D: \muxdile, V2S04
ANEEH T,

(2) A VHDL )7 . 479 Quartus [ 84, #E# £ 3 5 File>New, 7E New # 1
() Design Files k£ 4 1 SO 1915 7 2580, X B ¥k % VHDL Files, W& 3-2 fin., RIG7E
VHDL SCA 4% % 1 Hp i A an&l 3-3 Bron i VHDL #2)% .

File Edit View Project Assignments Processing Tools Window Help

I IR | S see s |T|>
Project Navigator ——— i« x
Entity

& Compilation Hierarchy

K] Cd

SOPC Builder System Al
[=I- Design Files
- &HDL File

Block Diagram/Schematic File
- EDIF File

State Machine File

SystemVerilog HOL File

Tcl Script File

Yerilog HOL File

WHDL File
[=- Memory Files

T Hexadecimal (Intel-Farmat) File
Ejﬁj Memary Initialization File =
= A = Verification/D ebugging Files
B — In-System Sources and Probes File
LR IComp1lat1 o LI Logic &nalyzer Interface File
Task[ - SignalTap Il Logic Analyzer File
B » Conp Wector Waveform File
[ = Other Files
o Fi AHDL Include File
Block Symbol File
P Assenbler Chain Description File
B Ti Synopsys Design Constraints File
- EDA Hetlist Write Test File =
‘ Frogram Device (Open
<] £

32 EEHEXHNIESEE

(3) U7 . EFE S File—>Save As, 03 2 557 B9 30FJe D \muxfile, 77 £ 3C
PF44 BE% A5 SR 4 — B0, B mux2la. vhd, SEAR R R 52 TR MR E . 4 B Do You
Want To Create $75 {5 BN, & B £ 67, Wl #2 LUF 9 7 i E A Q) TRE AR s 4 ik 4%
SO HEE AR TR AR
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¥ Quartus II — [Vhdll.vhds]

%P File Edit View Project Assigmments Processing Tools Window Help
DEeEdd & B o o ][I
Project Navigator . x {&‘c Vhdil.vhd* I
Entity |
by Compilation Mierarchy == 1 LIERARY IEEE:
2 USE IEEE.STD_LOGIC_1164.ALL:
& ¢ 3 EENTITY muxZla IS
4 ®mPORT | &, b, s: IN EBIT:
5 ¥ : OUT BIT );
S a5 6 END ENTITY wuxzla;
7 EARCHITECTURE one OF muxZla IS
4% 8 EBEGIN
“, o EPROCESS (a,b,s)
% 10 BEGIN
0 11 ®IF s = '0' THEN
12 =y <= a ; ELSE
- 13 ¥ <=h;
I o 14 END IF;
265 b 15 END PROCESS:
Tasks . x
— — 16 END ARCHITECTURE one ;
Flow: |Conpilation = [ i1
—_—

33 mBWANIRIT G

2) Bl TR

i [l New Project Wizard A] LR T #2482 TAE H 3 43 B TR 2 Pk DL KA € i )2
THECAR R 24 Bk 18 W] LU 2 A0 AR v s i Bt SOk HA U SO L 7 PE R EDA T AL,
VLK H AR5 R 50 Bk 38 4

E M HH New Project Wizard A %3+ T, Bl 4 mux2la. vhd i T8 . I X E
TR XWER LRSS Bt gad T EG%. PIROT.

(1) ST TR PG . #3388 File>New Project Wizard, B8 )« T F2 4% & 7 %t
TEAE AN 3-4 . Bl O TS AE SR b — A A A AL L 4R B SO D\ muxdile, B E
T3 30 mux2la. vhd, FEBA “FTIF 73 £, B H BLAN & 3-4 Frs i e i ol . Horp s —
1738 TR B e 09 AR R SR s 58 AT Ros I Il TR 1Y T/ 44, 1 TR 44 ] DL BT fi] L
iy 25 o 38 K ] SEAR AR TR s 5 = AT R R4

(2) Bt S A TR, Bl TR R 8 X 6 AE (] 3-4) F J7 9 Next #4876 5
AN 3-5 FraR A S N SO X E RE R S e TR A C R BT VHDL SO A I T AR
. TARRMSCIFM AR T A PR 55 —Mog i 0y Add ALLZ LR e i TR H
s A VHDL SCEFIn A TR SCURRE s 28 0y ik 2 5 o) U8 742 #1 . N T2 B 5%
Wk A G RY VHDL SCfF, frds Add #2806 SC/Fm A2 T2 .

(3) BEFEE bRt Fo Fa U SO X E AE (& 3-5) i Next #2281 . 3 3 4n (&1 3-6 Jr
TN ER A B X TEAE B SEAE Family R IEHN i R 51 FEMIE SR Cyclone [l R, 76 1
A #E Pin Count 2y 240, X B Frh R T 3 A B A 240 A5 Ay fr, X B 38
EP3C40Q240C8, Itth i Bl /& GW4S-CP++53250 &5 ) FPGA A . RAHRELK & L
B E AR R A AR VPR LS R 4R B 08 B 1 FPGA S B, R [R) Y 52 58 15 s & A b
19 FPGA Wt A ] 75 AR I SE PR s i £ B bRt Fr s

(D) A EAR MRS AR, ds (& 3-6 FroR B9 X35 HE i Next #2241 . 3 B 5 1
“EDA T E & & 7XFUAE 76 1 3% A AT LLBE 8 05 5 4% FI 28 5 #4528, an SR AR 2 BB iy
None Tl , /R #EFE Quartus |1 o {47 07 B2 FIZRG 2% » PRI, 76 I ER e 26 R IA 30T None”
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New Project ard: Directory, Name, Top-Level Entity [pag...

‘what is the working directory for this project?

ID:\muxfiIe _I

‘wihat is the name of this project?

Imux21 a _I

What is the name of the top-level design entity for this project? This name is case sensitive and must
exactly match the entity name in the desian file.

Imux21 a __I
Use Existing Project Settings ... |

Back I Fext > I Finish | i |

3-4 f# T 72 mux2la

New Project Wizard: Add Files [page 2 of 51 J?

Select the design files you want to include in the project. Click Add All to add all design files in the
project directory to the project. Note: you can always add design files ta the project later.

File name: || _I Add

File name | Type |Lib. .. [Design entr... |}FL version Add Al

muxZla. vhd VHDL File

Remave

Properties

il

LUp

Dawn

[

< 1l | ]

Specify the path names of any non-default libraries. User Libraries...

CBack [ Wet> | Einismn | M|

B 3-5 BHEXIHEMALR
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New Project Wizard: Family & Device Settings [page 3 of 5] @

Select the family and device you want to target for compilation.
Device family Show in ‘Available device' list
Family: | Cyclone [l j Package: Any <

| J Pin count: 240 v

Target device Speed grade: | Any v
" Auto device selected by the Fitter ¥ Show advanced devices
(+ Specific device selected in ‘Available devices' list I

Available devices:

Name I Core v... I LEs I User/... I Memor... | Embed... I UL I |
EP3C160240C8 1.2/ 15408 161 5160% 112 4 i
EP3C250240C8 24624 143 08256 132

002 39600 129 1161216 252

|~
|a

<Back [ Bext) | Fimisn | B |

B 3-6 kBRI

(5) ZERE . k2t Jiids Nexo #2413 Q&1 3-7 Fros i AR AR B AR5 7 X 3R AE , &
AT TR SRS B b S S E R . &5 i Finish #2 #1, B E 3 0€ 45 i T8, #0H 4n
& 3-8 itz (2 10, 1 TR 45 BT 1 (Project Navigator) 328 i 78 T2 00 H 4 J2 TR 45 74 1 4%
B A4

New Project Wizard: Summary [page 5 of 5] @

‘when you click Finish, the project will be created with the following settings:

Project directory:

D:/muxfile
Project name: mux2la
Top-level design entity: mus2la
Number of fles added: 1
Nurnber of user ibraries added: 0
Device assignments:
Famiy name: Cyclone ll
Device: EP3C400240C8
ED# tools:
Design entry/synthesis: <None>
Simulation: <None>
Timing analysis: <None>
Operating conditions:
YCCINT voltage: 1.2¢

Junction temperature range:  0-85 &3

<Back | [ Fnis | i

B 37 IRWEER
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{, Quartus II - D:/muxfile/mux2?la - mux2la

File Edit View Project Assigmments Processing Tools Window Help

pEE@|E sz o|maa K7 ewe 8] on]
Project Navigator o
Entity
Cyclone ITT: EP3CA0G240CS
e B mu?la ,5‘@

-&Hielarchy] B Files | 8 Design Units |

3-8 “IEEE"HO

@7 TR )G, 8] LI{#i ] Settings X% HE (Assignments 3 80 ) Add/Remove T1 , 7F T. 7%
FRR IR 8% i HoA SC . 7E AT Quartus [ B9 Analysis & Synthesis #}] ] , Quartus
K 3% Add/Remove BT HR I 7 A A BESCAF

FIHC T4 7 % 0 (Project Navigator) A] DL J5 1B #1 4 3 T F2 {4, B i Project
Navigator # H 524K % mux2la, 7] LAFT 102 SEAR B B3 S04 B mux2la. vhd, GnfEl 3-9 B
7~ o it Project Navigator % 1 [ Files Wi . AN 3-10 fr s, 1T LA ) TR 9 BT A 19 X
fF 3 A mux2la. vhd, DU 7 @ b SC b s BB DU . An 2R 2 0 R A W
7~ Project Navigator % 1 (AT GEAS /NG JEH] T ) L\ LAk & 32 B8 View— Utility Windows—
Project Navigator, 8 & ## Alt+0 -G I TS HE H O .,

-ax

§ File Bt Vi Froject Assigments sing Tools Nindor Help

DEHE & Lom ool (R 2GYO D> N[00 20
Profect Navigator “X & modtavhd I
Hati [
& Cyclons TIT: EFSC40R240C3 =] 1 LIBRARY IEEE;
=9 sule h ‘ 2 USE IEEE.STD_LOGIC_1164.ALL;
"y 3 EENTITY mux2ia I
, 4 EPORT (a, b, 3: IN BIT:
[ 5y : OUT BIT):
6 END ENTITY mux2ia;
u & 7 SARCHITECTURE one OF mux2la IS
A% 8 = BEG)
9 EPROCESS (a,b,s)
% n 10 BEGIN

g Q|| 1 =rs-ro omEN
12 my<=a; ELSE

1 < b :
Dotersty [BFies] F DesgnUnks B8 v
. B 15 END PROCESS:
Flov: [Conpilation El = 16 END ARCHITECTURE one ;

ok | ==
E b Conpile Design o
&

b b hnalysis & Syathesis
fo b Fitter Glace & Route)

< & |@ 3
Type [Nessag |

§ System / Processiig ) Ewbalnio )\ Info ) Waming )\ CibealWamng ), Enor )\ Suppressed ) Flag /.

F 4] 3| T

Besdy Iat, Ca1 [O Ben | Ide o

B39 FAIREE"HFAHAMEIEFZITIH



3) PRI IE

FEXT TR HEAT G 108 Ak AT S 00 20T 0 EE 1Y
WHE.

WURTE A S, TR 205 H Aot il 28
WP BE . HARE A £ dnl DUX PR R SE . ik
$F 3R Assignments—Settings I, 7£ 5 H 7 %
TEHE Pk £ Compiler Settings 3 | | Device, 1%
FEHBR S EP3C40Q240C8, A 3-11 fion. B
Je7F Show in Available devices” list #2 7 43 5i] 3%
& Package H“PQFP”,Pin count S “240” ., Speed
grade H“8”, 8K i ¥E Available devices %1 3 H i
#FHH AR A “EP3C40Q240C87,

4) ik

Quartus [l Fi P i B — 5 51 &b FEAR B ) 1

109
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¥, Quartus II - D:/muxfile/muz2la - mux2la -

o~
a.,‘.‘,‘?l’ile Edit View Project Assignments Processing Too

0= ﬂ é 1 mux2ia

Project Navigator . x

3 Files

35‘6 muxZ1a. vhd

Hierarchyl B Filesl 8 Design Units]

3-10 “ITREEE'AOMIEXHIIR

(145 X SEARE B 60 BT 0 BT I H AR B L2 AR LR A AS M ZR 45 BIDRE B I HOE BC it FPGA/
CPLD H bR . [R5 22 Fft ik 9 i 1 ST - 0 Dl BE A Ik e 05 50 SO L 1 4 72 1 H A

Settings — shiyan8

X

<

Migration compatibility

Migration Devices...

0 migration devices selected

Category:
Files
Libraries Select the family and device you want to target for compilation.
Device
/- Dperating Settings and Conditions ~ Device family ~ Show in ‘Available devices' list—
[+ Compilation Process Settings o :
+ EDA Tool Setings Famnily: |Eyc|0ne 1l L| Package: FOFP v
[+ Analysis & Synthesis Settings o | J Pin caunt: 240 v
Fitter Settings T
+ Timing Analysis Settings Speed giade: |4 b
Assembler - Target device [ Show advanced devices
Design Assistant (" Auto device selected by the Fitter rH
Slgr?aITap Nl Logic Analyzer (v Specific device selected in ‘Awvailable devices' list
Logic Analyzer Interface v
- Simulator Settings iy Device and Pin Options... |
PowerPlay Power Analyzer Settings
SSN Analyzer Available devices:
Name I Care v... I LEs | User|/... | Memor... | Embed... | PLL
EP3C160240C8 1.2 15408 161 516096 112 4
EP3C2500240C8 1.2¢ 24624 149 BOB256 132 4

EP3C400240C8 1.2¢

39600 129 1161216 252

3-11 EEHFRSEYE
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EI?EEE?KE%%M%?@EE&@
TBHE

SCPFAE . i i 50 N TR T SO ] 09 J2 U 235 48 4 3R vh 32 U B A 468 B M IZE o
TR AR AR L BE RT3 HE IR L AR 5 3 S 2R YRR 7 A — A S AR Ak 1 DA 3 SO R SR Y H
5% I 3 ] SO IR A 2 0 i A I SO A S — A B A D T Ak b B

N S £E 33 B Processing— Start Compilation Hi, J5 8l 4 8 4 1% . 12 5% B P
WH 1 4 13 (Compilation) i 4% Quartus [1 XT3 15 A (7 22 35 b B4 A, L b A0 355 HE B8 L B
I e SCAF AR L B B LR A VIS T BT SO (7 B S 5 g R E B SO 2R B DL R T B AR A
PRI TARRE P 2 S . a2k TR B SRR R R B 345 J5 78 T 7 1Y Processing #2H14x
R ik anIEl 3-12 it 7R o X T Processing A2 17 H (9 1 A0 4 2R 15 L AT X o 2% 3, B it
XS R VHDL SO 28 TR AR 0 4040 (BB ) AT & B0 SO rh 5 158 . T30 IE A it . Pk
ok B 2 HEBR T A AR . TE R IR AR B 2 ARG D IR R A 2 T b
R AR ORI 2 GO0 B R R TR R R T 2 AR E R . R EE D
) Processing £ H1 A /R Messages % H (R BEA /NG T, 7] DAk £ 30 8 View—
Utility Windows—Messages, 80 # #% Alt+3 4 & 4E$TIF Messages & 11,

Quartus 11 - D:/muxfile/ausla - mux2la - [Conpilation Roport = Flow Summary - [2]x]
-2 - ] & © 9 0
Project Navigator | © Compilation Report - Flow Summary
Bty [
&) Cyclone III: EPIC40R24003
Lo et dg

Flor Status Flow Failed - on Dec 09 15:02:34 2013
Quartus I Versien 9.0 Build 132 02/25/2008 ST Fall Version
Revision Neae .

Top-level Entity Nane

" D Hiererchy [ Fles ] ¢ Design Urits

Taks z
Flov: [Conpiletion K|

¢

gﬁ Systen(4) ) Processing (8) { Exialnio J\ Ina[4) ), Waming }\ Citica Waming J\ Eror (4] J, Suppressed )\ Fleg /.
Effesage 0oi1d 4| # |
For Help, press FL ® B Ide L)

B 312 =BFEFFHARERFR

AR 2 P R AT AL BN P 3-13 iR 8945 B . Compilation Report #2424 3% 4t o 1t
F e 5 2 o, Bl FOvh 25 T ] DLTRAR 1 2 735 20 A 45 2R GBI 7R Flow Summary 3
fE ). Flow Summary % F 2 7s 6 AFFE I G H i o ey 7 24 i CREFE I T — 2
HHTC A AT 0 A RAM 745

2R TimeQuest Timing Analyzer I+ 75, W G 18 i 8 oy 7 i 81 11} 1) 4% 500 H
A B YT LR A ARG PP AR TR

SR Ly Fitter R+ W BE I8 i # oy T 101 87 4 4 4% 20 8 31 24 /i A% B A5 A G Al
(GRS RESTALE S
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5 Vindor Hilp

xS P [BO k(O P A0

Project Navigator I X © mulavd | © Compilation Report - Flow Summary
Entity BEmmaeie
- ConpiLation Beport
& cydme 111 BFARAEE G Lucu Fotice
i we2te B Flov
Succasstal - Mon Dec 09 15:08:44 2013
8.0 Build 132 02/25/2009 ST Pull Version
g ne2le
w2la
B hesanblar Cyclone TIT
# &2J Tinstuast Tining Analyzar ERCaRAcS
Final
e <] & Design Unis
B Hiersrchy [ B Fles ] & Design U WA
1/38,600 (<1%)

s 1/ 38,600 (<1%)
/33,600 (0%)

0
4128 (3%)
0

/1,161,216 (0%)
07252 (0%)
0/4(0%)

Type ~
y
b
b
y
v
@
y
P
v
< >
g Systen (5] ) Processing (105) £ Estalnio )\ Info(35) )\ Waring(7) , Citcal Waming (2) ), Evor )\ Suppressed () )\ Flag /
£ Message 0or 163 2| #f |
For Help, press B i) de I

B 3-13 HIFMIMER

5 PiHE

Xof TR I 4 15538 0 S5 > 200X L T e AN S P AT O B3, DT R T 4 R
R ESR . PL VWE SO J7 Ui 0 B B e dn 2B 3R an F .

(D FTHF I g 8% . P £ H File>New I, 7F New X HE i £ £ Verification/
Debugging Files F111] Vector Waveform File([& 3-14) , By OK #5241, B i 3025 (T 4w
Ay (A 3-15) . FE A PABEHE KR View—>Full

Screen HF M T AL Fry 2 e 0 mrs (I

PSS/ AR T O S  SPCaie n -
(2) BERAj R, 767 35 5 Edit> S:;EkL g:fguam/smemanc File

End Time 57 , 26 3t} B9 4 552 Fi1 Time SCA fE ST

B A50”  A0L  FE as”  HFE 3-16 % o BV RS A O e

UG I ] B 50 M it OK 4541 45 7 Vel DL e

1 BT 7 20K 5 6 B 2O T B A — A | | e

Hexadecimal (Intel-Format) File

ORI B 1 T 9 B0 T | | e

S BORD I . A0 B B 5 B R E Pty
Y% U5 B Y 7 AT O 2R T i Secuvason
SR N . N N =I Other Files

BB S S R, S B L t AHDL Include Fie

SRR N b Block Symbol File
@ ’ Jrl'J i IK/T\‘ 'fﬁ E EE %%? g Eg E?J‘ IEﬂ ﬂ‘ FJE ‘ﬁa‘ﬁ‘? % IL /l\ /J\ ChainD};scriptionFiIe

Synopsys Design Constraints File

FF DR st 077 2 48 8 — i 95 T o :

(3) 7 #&LPIE M. i+ File 'Y Save As, Carce
B LL 44 mux2la, vwlCBRIN ) 1% TE SCIFAE A SC
% D:\muxfile 1, 314 BUKBEEIH
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LA R e e T S e

-8 x
[Dede & e o s EE RIS
€ nuiavhd | @ Compision Repor - Flow Summary | 1 Wavetom.vwi |
Mmm-na 218 || Poitr 1205ns Ineval | aTm Start End:
™ s 10.0 ns. 20.0 ns 300 ns 40.0 ns 50.0 ns 60.0 ns
\ K o |7 . e ' ' ' ' '
% I—
Q
C]
#
g
¥
3
:
:
@
a
g
c
g
g
B
15
P 3 2le

]

B 3-15 EREmEs

End Time (x|

Time: |5[| us 'I

~ Default extension options:

Extension value: ILasl clock pattern j

~ End time extension per signal:

SignalName | Direction | Radix | Extensionvalie |

Cancel I

3-16 REHFEMERKE

(D) B AEST A, BT mux2la B3 DS S S EARERES ST, FEALT
W5 3k (Al DT e —Ff

ik —. e ERE 3 View— Utility Windows—Node Finder ¥ , H 1 4n & 3-17
fi 7R Node Finder % [, Py List #2401, 7] AI7E T i A9 Node Found £ & 2 4 451 .
Al DL BUbr 22 8 5 T Node Found #2 91 (4 5] 1, #i 3] mux2la. vwi 435 % [ 5 ) Name



L IS NS 5 ) mux2la. vwi g g 0 A 3-18 s,

W File Bit View Project Assigments Processing Tools ¥indow Help

8 x
|DEU@ & L e o cmwan M sGEG D> wD R[O® !\?‘
Node Fider x
Nt I ] Faoc s o] Cotome. | [ ] q imum : | @ Compiation Repat - Flow Summary | {8 mux2ta.vwi |
ke[ ]l ¥ T = =] Maste Tine Bar. 218ns o[ poiner | 20m Inteval | 198 st | 0ps End | 500us
lodes Fourd: Y " vp 10.0 85 2.0 ns 0.0 5 0.0 0 ]
None [ Assgmens [Type [ Ciesor A = .5
> Unassigned  Input User entered *®
b Unassigned  Input Uses entered
s Unassigned  Ingut Usereneed &
oy Unssigned  Ouiput Userentered
"
o
x
o
i
z
el
A
=
'@
%
)
< 3 |osem o jom L]
= -+ .
3-17 NN /% H 75 R & O (Node Finder & 0D
@hh Edit View Project Assigmments Processing Tools Window Help & x
[DER@ & (i oo JHsEYO O Tn[O O ® e
Tx .
Nt o] Feefreeor o L Oknta Eq :ngth | @ Conplalion Repat - Flow Sunmary | {8 mus2ta.vw |
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Select a programming hardware setup to use when programming devices. This programming
hardware setup applies only to the current programmer window.
-

Currently selected hardware:
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Hardware | Server | Port I Add Hardware... |

3-37 Hardware Setup X7 i &
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Select a programming hardware setup to use when programming devices. This programming
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[ 0000 = 0001 | 0010 |~ 0011 | —
[o100] I Ly

—clk
[ 1000 = o111 = o110 = o101 | inst
B 3-42 HHBRESEBE B 3-43 HHBITHEFS

R332 THBERESEBR

Qs Q: Qi Qi (e A Qo Q!
0 0 0 0 0 0 0 1
0 0 0 1 0 0 1 0
0 0 1 0 0 0 1 1
0 0 1 1 0 1 0 0
0 1 0 0 0 1 0 1
0 1 0 1 0 1 1 0
0 1 1 0 0 1 1 1
0 1 1 1 1 0 0 0
1 0 0 0 1 0 0 1
1 0 0 1 0 0 0 0
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5. XIBREZSETR

1) g T/

TSN — AN SO e DU BT A BT SO AT SR e L A D \entl0, VR
S e A AN B S, SO AR TP R B AT M . ARG B AT Quartus [T PR B R
H. File>New Project Wizard, F| ] ] & @ & T #2 . W18 3-44 froR . 458 @ LRERAFH &R
D:\cnt10, TR 4 FISE A4 PTHL ent10,  Hofl 35 B 3k 700 n] DA 45 BROA (R, 6 2 T /% DL 1 1%
B TERE 3 AT IR AR AL B — LA L 5 22 00 102 SR SO 4% b A0 e AR R — B

New Project Wizard: Directory, Name, Top—Level Entity [pag... [Y|

“What is the working directory for this project?

[Dventin [=]

‘What is the name of this project?

Icnl‘l 0 _I

‘What is the name of the top-level design entity for this project? This name is case sensitive and must
exactly match the entity name in the design file.

Icnﬂ 0 _I

Use Existing Project Settings ...

pack [ Wext > | Finish | B |

B 3-44 GIE TE cntl0

2) VHDL # % A

(1) #rg VHDL U T SCAR SR 4% . HAK L BR . 3 8 File—New, it %1 i #E ,
¥EHE VHDL Files SO, G &l 3-45 FroR . S8 MU - BRAT FFAE & 4 58 4% JF A48 B — A4~ =8
FIHE &S ORAF S0 ent10. vhd,

R ZXBEHAIEGET I AL RS ERLE R, ER LAV E IR T E
e,
(2) FIHCAGRELRAE entl0. vhd X EARR)F P3-1 40%, SRJ5 #4838 58 File—>
Save AF:FE A ent10. vhd,

2 P3-1 cntl0. vhd

library ieee;

use ieee. std logic_1164.all;

use ieee. std logic unsigned.all;
entity cntl0 is



KRR H AR

port( rst,en,clk:in std logic;
oc:out std logic;
g:out std logic_vector(3 downto 0));
end cntl0;
architecture bhv of cntl0 is
begin
process(rst, en, clk)
variable tmp:std logic vector(3 downto 0);
begin
if rst='1'then
tmp = "0000";
oc<="'0";
elsif en= '0' then null;
elsif clk'event and clk = '1' then
if tmp=9 then oc<='1";
tmp := "0000";
else tmp (= tmp + 1,

oc<="'0";
end if;
end if;
g<= tmp;

end process;
end bhv;

File Edit View

[oses]
Project Mavigator

Entity |
@ Compilation Hi erarthy[

Tools Window Help

xsee s (o> >

SOPC Builder System

[=- Design Files
AHDL File
Block Diagram/Schematic File
EDIF File
State Machine File
SystemVerilog HDL File
Tel Script File
Verilog HOL File

[=I- Memory Files

= @JEJ £J Hexadecimal (Intel-Format) File

Memory Initialization File
T 1= Verification/D ebugaing Files

In-System Sources and Probes File
Logic Analyzer Interface File
I?S_kﬁ SignalTap Il Logic Analyzer File
Wector Waveform File
I=I- Other Files
AHDL Include File
Block Symbol File
Chain Description File
Synopsys Design Constraints File
Text File

Flow: ICompilation

Timing An:
EDA Fetli

ogram De

B 3-45 EHEHEXGNIESEE
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3) e fF Rt g

PEHE £ 32 B Assignments — Device i, Xf % 7F # 17 B ¥, ¥ £ Cyclone [ & %1
EP3C40Q240C8 15, k£ 3£ B Processing— Start Compilation % & 8. T B £ #% 4l
B XA TR B AT S k. W 2R entl0. vhd PR 2 BB B A RS BRL TE T T
Processing AbFRAZ rfr2x ot R o Xk 45 3R 42 s, 8 A7 Hh B 00 067 B L SOIE B R S P 4 D
P 5 B2 G 13

O iR

Xof TR 4 Gt 15 3 A S 00 20K ) B RITER F  J EAT O ELR LA T A B R A
R BTSSR, LL VWE SO 7 U0 B AR iR i 2P BRan R .

(D FTHWIE 4 2y, £ F K 9 File—>New T, 78 New % 1 #1#%& $£% Verification/
Debugging Files 1) Vector Waveform File, 8 OK #z4H, BI H #2589 I TE S BE 4%

(2) W& 7 BN XA, 78 332 5 Edit—>End Time 3, 7258 1 19 % 0 9 Time % M
A I A BT ELIF ] 40 100, SRR B HE " s”

(3) AERLPIESCHF . 4% File iy Save As H LA Ry ent10. vwiCBRIN A 93 T8 SCAHF
FASAEI Di\entl0 Hr

(4 W AFZ R ¥ TAR entl10 3 E S A ABIE S de b . ik 2 E kit
PEESE B View— Utility Windows—>Node Finder 150, F Filter f£ 1 #£#¢ Pins: All, & 5
i List #8l, TO27E M Node Found £ i 8L 1 i 19 mux2la TR MY i A 3 11 5]
JED 4% Cln 2R ot % 3% AE b By List AN o, fy 2 OB g 3% — W, B E #% Processing — Start
Compilation, R 5 & UL F#AEL ) . AT LU BUbR 42 88 52 i Node Found 42 H1 iy 5| A1, 4
BF] entl0. vwi k% O Y Name £2,

(5) ik AVIE . BT IE B 1 22 M Y 4 B S s # L 4 B o L O Bl i K
AN @ I L TEIHE G i Xl BRUbR A B PR RO B0CA B B (i) A0 LA B Ak T
ML o KNy ECI R AR AR TR R O R G . B O G B AR T 1T Name £ (9 1)
T4 clk il 2 AR IOE 5% F R 22 9 0P S AR T ARSI B S S R HL (LR 3-20) L 78
Clock 7 H H 8 clk B8 I 285 Clock % (9 Duty Cycle 2 (5725 Ho . BRIA 9507, I
50% s . SRJE PO AL en A rst A ERSF . S S8 B B R N 3-46 TR .

N ps 5.12us  10.24us 5.3 us 20.43us  25.6us  30.72us 35.84us 409 us 46.08us  SL2us  56.32 us
N DR 2 ‘ . ; : ; : : : 2 7
e a
A Ees 2432 us 2432 us
o
2% [0 1k B0 migilgEgmipilglpihipiglpihplg iyl i
@ [ 3 t B0 |
2 B1
@3 BX
Y EXOR=R B X0 TR
25
N N s s T
B 3-46 HHBHERKEE

(6) MR iA% B . g I 3-46 Fros i A5 5 cq ZEMAY ™ 47, W BE & TT 1 2
LT AR s WRXGE I 75 ZE M A5 5 A 10 - 8 55 X 2 5 B A% =X B 1
WHE . 7R 3% X I HE B9 Radix #2470 4 Bl 2 £ 0X BLA] % £ 0 75 5 - i i) B 80 Unsigned
Decimal"i5 7730, fieJm X Y SO PR AF A

(D) PiESS RS T LB R RO IS Z 0 P B8 . e $ 338 B Assignment—
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AR A aw:ammmm@
SR HIE

Settings, 7E Settings & 1 A7 1& £ Category— Simulator Setting, A LLi& B B A X “Time
Mode”, BRI\ K “ Time” ., A 0] LI 34T 8 4G 0 “ Glitch Detection” (1ns 5% &) 2% B .

() Bl ES. AR E Y, fE1E# F K 8 Processing—Start Simulation, 8¢ 3 £
& Quartus [ TER: @ 24, G0 E, B3 BB “Simulator Was Successful”, {j &
45

(9) W%z W IE A Simulation Waveforms % 173 5 < B s ¥ H . a0

Kl 3-47 Firos

S HA R, A

Ik Tt o ps 5.12us  10.2dus 153 us  20.4us  256us  30.T72us  35.84us  40.9%5us  46.08us  51.2us  S6.R us

Hams % 9 s 32.317979 us
A o
e 0 I | 1y A g A T 0 1 e A e B
o Bt | ro EEEEEmEEEE
|2 o B1
‘ (@3] oc B1 M1
=2 q W0 [ T B 3 1 5 3 T B 3 [ T z D & 0 T

347 HHESHEHERHEEE

EE: Quartus [[ #4945 AR B XA P, kB %4 Cx.vwl) 5k B4 A RS L4

(Simulation Report) 5 4~ F 45, 4R & B 315 A (Processing—Run Simulation) & , 3 & #
AT ARG kB A, A B I XL F“Can’t Open Simulation Report Window” , /23R &
5 AR W T B AT A5 AR B AR % 8 B £ 3 % Processing—Simulation Report,

AR TC ik e I I8 o B 1) gl B0 B A O R ECE OB K E— s |, ] DU
Simulation Waveforms & F Z: ] T HA2 /R 46 /N "4l & JH BUARTEBOE b 42 s o ihi
s B X B BEAT ORI o W SRR e g ORI, AT DU BRSO
T J 35 7 10 P AT ] A7 3 FS) P B 500 7 11 1) Zoom T, 78 H B R $i7 2% Hrp i £ Fit in
Window, 45 BRI 4 /1Nl B A S i 1 s H B A 4 38 D) e 7T BE 2 0 BL A ) KA, &5 A0 IR
(2) % B BCA ) DX 38, 15 3 30 45 LA (]

5) N RTL A [ W% 8%

Quartus [[ A 52 8 A £ i 38 15 75 5 W % SCfF (VHDL, Verilog, BDF, TDF, EDIF,
VQM)XS I RTL g B A 8. T .

P FSE B Tools— Netlist Viewer—RTL Viewer 3, 0] LI I entl0 TR & E IR
RTL L #1E anEl 3-48 Fros . XWiki BB A SR B, sl 38 48 20 M 45 300, v] 38 )2 T i 45 2 IR
B HL PS50 . ] 3-48 AT LLE Y, ML B 2l — > B A L — DIk 2% L4 A 2 B IR PR AR AN
— A~ A4 A AR L

X TR ey RTL B vl A ] D B8 o 8 & Fileer " i f o B% . BV BUBR A7 8 50 6 0%
B e 5 0 1) b SR B rh 3 #F Filter WY Sources 5% Destinations, H 7™ 42 AH 1 19 {7 1k
H, %

IR 3 B Tools— Netlist Viewer— Technology Map Viewer I, °] DL F F| A& T
T 4 B A7 v B2 ]

6) SIBIEE N 5 R A

TEMIEFE GW4S-CP 4+ 3245 &5 1Y H BB 20 No. 5, il EP3C40Q240C8 Jth Jy, il o £
G B R (R 2-14) , 0 & TH B A 1 5| I8 E Jr RNk 3-3 iR, EME 8 clk 4%
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Hierarchy
=

Page Title: | CNT10

- O oo
= I3 Primitives
=D Logics
w D tap™3..0]

=L Dperaters
L hddo

{3 Equald

=& Registers

£ oc"regd

2B 0GP~ dE

mp3.0

Equald

oc*re
=4 tmp[3..0]
£ tnp[0]
£ tmplt]
£ tnp(2]
£ tnp[3]

N
P

oL

> oc

LS
=

- = Pins TSt

A -2 Input

en D>
oIk D>

% 4 B Dutput
o Hets

Hierarcl hy LislA Find (

=3.0

& 3-48

cntl0 T2 R RTL HEEE

ClockO (5 152 Jfl, A4 7E 4Hz 1) 5 [ 3. 0 DN i L BR A — R - BL SIS o A 2R e R i

L » B A8 A 2 18 s R 1) KA

F33 HHIB[SIMBERR
WMAN/BHES ap & 5| B & R 51 B 5
clk Clocko Clocko 152
rs ek 2 PIO1 18
en FiekgE 3 PIO2 21
al3..0] B 1 PI019.,PI018,PI017,PIO16 69,63,57,56
oc LED 4T 1 PIOS 44
P FE ¥ B Assignments — Pin T, #H qn ot 3] o £ s A
P 3-31 Fi/R (X6 AE . 76 Location b5 FAME 5 T T
W52, BB E S 5 AT 3-49 Bk, MEH T | Tl = F
AT B Location 51, 208 3. 1.1 S DA | o G
AP VRN Location 31, 5 #4717 8. L XTI F o o e
HE. BB AT 2 PR — K > 1
fE Quartus [[ 1 3%E ¢ F 3¢ B2 Tool — Programmer ? <<hen noder>
YT, B3l g A 71 1 B Hardware Setup % £, & £ B 349 MBI HYE

InFE 4% “ ByteBlasterMV [ LPT1]”, Bk 7 ¥ 5 L
3.1, 1 BySEga b B 7) 0 R g A A R 0

HE TN AR AT Start 241 BIgE AT H AR 25 2F FPGA RORCE F 888 1E . 3 B2 ir e
MR E SRS A . R S A B A A . s A2 ) Add File 3% 401 . F sh ik
PEBC B S fF entl0. sof, 4 Progress i 78 ) 100%, DL M 78§ &B 09 &b 30 82 oo iy 3

Configuration Successful B}, /R IR FE T,

TR LB B AR T A B R B L 0 S AR U N, 57 P B 1
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TEHIE

2.3, (AR TR LR BOISAF 1 A0 LED AT (% L 0 3E 4 ss i Th fig

7) SignalTap [ SZAF

Wit % B R T 52 2 1 B S W ASOHORSE T SR Oy X0 0 B ROR T AR BT AR e Y B
PEYIRE T IR AN GE 1 o AN W7 75 28 8 0 EAT R R 4 ) It A8 A5 T S FRIE . SRy T T i
S pa) @, B AL LUK — s 800 BRI T B AR e i R Gl U R A A Aok e, X
R A GBS . BT DARE R T SO —IF T 20T B s 7, DU B bR
O RS 5 T AR I AE R T SN 52 iR A R G Y O R TAE .

X2 Quartus [l #7 SignalTap [ f H Y. 7ESEFR WM, Signal Tap 1Kl 75 19 4 A
SR T HARAE P i At RAM I ESBMAK) 1, 4R J5 i it #51F 69 JTAG 3 106 R
153 1915 BAR I 36 AT LT R A3 #T

i AR 2 X SignalTap [ Fo 80 Bt b 59 BT A7 J2 UOBE B ) £ 5 35 2R A7 I
AT LS Z2 B B0 8K 3, i LA e 38 1 1 B LARA o 1S i & BEE S0E B He

PUF P BR AR 1 & SignalTap [ SO/ R AT 5 B 19 A R

(1) ZSLF i Signal Tap [1 3.

(2) [ SignalTap [l SCOFEINSE ] I 1) B4 SLF 75 5. 7] LA Node Finder
i) SignalTap 1 38k #5% A #7425 & F A JR A 26 )5 19 SignalTap [ 545 .

(3) &5 B A S5 3 B — > I 4

(4) T HA 8 79T, 40 SR AF R BE R0 ik 2 91 O 15 5 4 T 4 R ai /i i B R R IR
g 1,
(5) W HFE, AT 5 % Advanced Trigger 2514,

(6) HwmiFiit,

() Xt AT AR

(8) 7E Quartus I A4 b sl Al ] A1 322 38 53 A A S5 6 4 SR 5 Rl 43 AT A 5 55 dis

Al L LR D RE U i Signal Tap [1 #2843 H11X.

(1) 242850 . SignalTap [ & 58 7t AL TE B A A 14 b SRR 2 8 0t A By 2 4
AL, AT LA H I D 6 A i 44 v A B0 B A g Ny B el — A9 38 B 4 BT X O AE
Z i A 2B B 4 A A 1 HTAS [m] (Y

(2) S48 PR SEM) 45 A VR AE 24 S8 B g 37 JF AT SignalTap 11 % %8 73 17 .
A LAl B e AE SignalTap [T 3C 4 o & 57 M Bk R0 8w 45 55 1), 56 4 A4 B8 4% 7 Y i
SignalTap I 3T (4 BT A 52461 54> A G 52461 9 >4 iR 2 DL KR DG 52 4] v 4 7 322 6 e
R AAEAE G LCRR B . S0 )8 B AT LA B B ARG A A 32 8 43 BT AR g AR B BEOR 1 B R AT
A&, A LAk #2248 50 B A DL S #% Run Analysis(Processing 3¢ H#.) 3 [m] i) Ji 3 24~
BT

A28 ey A ] Signal Tap 1103 1A 340088 oL 8% 9 07 12 .

(1) THF SignalTap I %% & 1. £ £ 3 5 File>New T, 7E New & H 1 3L £
Verification/Debugging Files H1 {4 SignalTap [I File, B OK ##4H ., B HH ¥ SignalTap [I
2 7 1 CIN P 3-50 FTzn) .

(2) WAFRHWAES . HERdi EHERY Instance 224 /Y auto_signaltap_0, B ¥ttt 44 . 0
ents, KR H AP —HFFNGES 4. B TIHRARNAES 2 7 onts £ 1 925 14 XGE , B3 H
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8 Quartus I - D:/CNT10/CKT10 - CHILO0 - [stpl.stp]

ject Proc
(=] invaiid JTAG confguation  +| @) | B

I ,7mmw, T 5] x | 1740 Chain o
Instance | Status LE n| Memory: 0 MS512MLAB: NA | MAKMIK NA | MRAMMI44K NA |
B avo_signatep 0 Notruning Obis NA NA Hardware: ha KLY

O T e [
- O

ato_sepatep.s & Mler 1 changes - S Contgutn

x
[ Tiode oat k'nblel'lrm Enable [Trigger Condiions | Clock: 0
Daa

Sanpledepic [128 v] RaMtpe:
I™ Segnerted

Storage qualfer

Type: 2 Contivaous. -

[l e v [ v @ ]

=
B ete | 5ot
Histatchy Display: X I Datalog 8
8] auo_signakap 0
3] ste_sigaltn0
Fer Kalp, pross L i

& 3-50 SignalTap I %45 N1

Node Finder i 1, 5 List #2481, B0 E AR L TERM WA E S, BN HE S
PR BG5S 4 4 Dk B M55 o N 4 B AR B4 tmp 55 F oc. i OK
T B AR X 255 A Signal Tap I {55 WL 6T, Q& 3-51 FroR . FRAZH TREM
FHETEE S clk W AME S EEE KO AEAR T T 4T 508 A TR 09 E M B 55 clk
HAE AT AL RAEBT B, IAMINIR A BZE S RF A RLE S AW ; 2 H{ES
AT A s P A5 B0 I AR 48 S PR s B2k P g N Al Bl B R A 2ok 2 1 AT S B LY
55 . iX &35 Signal Tap 11 JCi§ #b 5 I A NIt 2 A9 % .

Instance | Status | LEs: 4?9| Memory: 1152| M512M
|£| chts Mat running 479 cells 1152 bits

chts Ié’)\llow all changes j

Hode Data Enable |Trigger Enable (Trigger Conditions

Type |Alias Hame 9 9 1V [Basic |

o o v V 2

o q 2 ¥ ¥h

o tmp "2 "2 *h

351 EAFNES

(3) SignalTap Il Z ¥ &. W ek A& 80 B ALK T AF B 80 {5 5 Clock. 7
SignalTap [I 448 %7 1A 0§ i Clock #24 MFg“ -4 8 B B Node Finder % 1. &
TR S PPE S clk A9 24 0 A A R BRI Bl s 4235 78 Data fE (9 Sample £ 28 £ %
FETRIE N 1Kb, (BN RE — B W ents {55 4109 B — 070 f5 5 #0245 R R 9 R AR IR



132

AR A 'aw;%;m%ﬁ&qie
SR HIE

JE T LA IR 48 15 D0 A5 5 R PR ZE SR A5 5 A B 5 5 B, DA KOAR TR AT g 5 A ESB/
MAK ) FA ﬁAﬁﬁfE%ﬁ(ﬂﬁ DA R A MAK AR5 F RS G .

SR R IE T WA AE 5 125K 7E Trigger HEMY Trigger Position #2235 5 R AF IR JE bl
i fish 2 B4 o7 B ,ﬁ[lﬁ'_ﬁ?q: Hif & fi % Pre Trigger Position,

e 2 il R AT S RN il & T AR B, ik R DUAR A B AR T SRR 3k 2 L 7E Trigger HE Y
Trigger Conditions £2iE#“1”; % d Trigger in &2 iEHE , I 7F Source Rk A F 5. 1F
I EHE ents TARPHY en AE Nl A (G 55 76 Pattern R T4 fil % 77 30 (Rising Edge) ,
B4 45 en i B FHAT )5 » SignalTap 11 78 clk SR80 N MR P E onts (55 AW {7 5 #H17iE
LA BN . Signal Tap Il 280808 5 0 1& 3-52 fis.

0 Quartus II - D:/CKT10/CKT10 — CNT10 - [stpl.stps]

File Edit View Project Processing Tools Window

B Compile the project to continue | ) A

Isance Menager Corgle e piectoconirwe | X | JTAG Chan Conigaotor: RS ) x

Instance Stalus | LEs 571 Memay 18432| M512MLAB: 0/0 | MAKMSK: 3126 | MARAMM144K 0/0 v

Bons Not rurring 571 cals 18432 bits Oblocks 3blocks Oblocks. Hardware: v| _ Seuw
Device Scan Chain
| SOF Manager D

| Mlow 1 chenges ~| Signal Configuration: x
Tiode oata Enable [Trigger Enable [Trigger Condtions | r Al
T e | r
2

we | 9]

A -

@9 14
" Tiigger
Triggerfow contck [Sequenial =l

Tiggerposiion: [$2 Pre igger posiion -

Tiggercondbions: [T <]
¥ Tiggerin
Sucefr [0
Pattem: | /" Rising Edge v
™ Tigger out
e
e I |
Latencydsley: [

0 Dote 2 setw

Hiestchy Display: X [ Daalog R &
@ i B

tows
+ o

For Nelp, press Bl i

B 3-52 SignalTap I S#iE 8

(4) A7 RE . Ve384 File—Save As i, #i A Signal Tap [[304:4% 4 entl0. stpl (BR
N2 . B Save F#41 )5 B B — P75 “Do You Want To Enable SignalTap [, i % 8
Yes #2438 A B 04 B FF L Signal Tap [ 30 (0O 5 TR (CNT10) 4N 9 £ — & 23
& /&R, IE— R 8 3t FPGA & 22 58 B S i AT 45

ISR BAh No $4L. W2 A & 2% & . 7 k2 8 128 A Assignments f1 [ Settings
1, 78 H Category £ % # SignalTap [I Logic Analyzer, 7E /5l % 0 SignalTap [ File
Name #= /7 % 7 & 7% & 9 SignalTap I File X 4 4%, @1 cntl0. stpl, Jf ¥ 7 Enable
SignalTap [I Logic Analyzer & #EHE, W& 3-53 PR, iy OK %4 BIAT

BN R T 2 R Signal Tap [1BEE 9 8945 5 2 30K 45 0 o A AE #4 B 7™ i
HI AN T SignalTap [ )t R B 2. ik 2718 3-53 Fron i H 1 OCH] Enable
SignalTap [l Logic Analyzer i, F- 45 i . g e — R BRI AT,

(5) YRiIFT 2k, 1 oCik+stF 325 Processing 1Y Start Compilation T, J3 3l 4> F2 9 15 5
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Settings — CHT10 X

Category:
General SignalTap Il Logic Analyzer

Files
Libraries Specify compilation options for the SignalT ap Il Logic Analyzer.
Device
Operating Settings and Conditions W Enable SignalTap I Logic Analyzer

Compilation Process Settings
EDA Tool Settings SignalTap Il File name:  |stp1.stp J

[

Analysis & Synthesis Settings
Fitter Settings

Timing Analysis Settings
Assembler

Design Assistant

+

SignalT ap Il Logic Analyzer

Logic Analyzer Interface

Simulatar Settings

PowerPlay Power dnalyzer Settings
SSM Analyzer

+

Cancel

B 3-53 & SignalTap [ 5ETLRE—RFEAER

SR G FE M Tool>Programmer T, i N AR 4T Start % 41, F # Sof X3 H 5 £+
fFe TERZ AT TR T 514 A, IF H 42 25 1% % T ByteBlasterMV 3,

SRJIGHERE E S Tools H1 (¥ SignalTap Il Analyzer, T SignalTap Il . #% & 4T ¥ 3¢
WITRFZGRWI . ERE JTAG O BOE AR . 88 3-52 A B Setup $H, EH£
fifi 438 5 A 20 ByteBlasterMV, #RJ5 87 T 77 9 Device ££1¥) Scan Chain #¢4H , X 52 56 A i
Al . R AE Device #4rf i Bl _E FPGA BRI 5 44, 40Kl 3-54 i . £R 25 JTAG 18
51 0 IE &, o] AEAT I

Instance Manager.  *q % M [E] [Readyto acquie ] X | JTAG Chain Configuratior:  [1TAG ready @ x
Instance | Status. | LEs571|  Memony: 18432 | MS12MLAB: 0/0 | M4KMSK: 37126 | M-RAMM144K: 0/0 |
ants Notunning 571 cels 18432 bits Oblocks s Oblocks Hardware: | ByteBlasterhV [LPT1] v| _ Sewp.

Devie: | @1: EPAC40 (W020F400D) ~| ScanChan
ﬂ SOF Manager. |:|

B 3-54 SignalTap [ 5356 &85 £ &K

WS 7 BB (B No. 5) Firgs il fe gt 1.2.3, 2§15 5 en=1.rst=0,ffi §}
Bgs TAE . clk B Z A 78 Clock0 b5 65 536 Hz 5 B i .
(6) B 3h SignalTap I #17 KRS8, WA 3-54 Fizs , Bidi Instance 44 “cents”, - 1E
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ﬁrzmzﬁyksvr;amzzmsﬁ@
TBHE

P& F 32 B8 Processing Autorun Analysis Wial# B T H A Y Autorun Analysis #41, /8
3l SignalTap Il . SRJEHHE 1Cen) i ARE] & 77 4 — A BT /B2 SignalTap 11 B RAE
fil % A5 5 X B AEFE SignalTap [ £0¥i % M@ JTAG HER R A 2K - FPGA
A S I AF 5 CAN I 3-55 Fros » Y BRUBR 9 20 BB B R B4 /N BB ) o BE 2 11 1Y B v Ak
s J2s SR AR TR JBE 110 — 1 7 8, R 1024 157 (R il & 7E 12 Yo R BE AL o T BUAR A B PRl g
55 1T LUR A BE SR B2 Bus Display Format 3¢ 8 £ /s i 61, Wk £ 085 5 -+ i i
7 (Unsigned Decimal) ,

R Quartus IT - D:/CHI10/CRTL0 — CHI10 - [stpl.stps]

File Edit View Project Processing Tools Window
=) [ ] Acquisition in progress -2 3
Instance Manager W | [Aequistioninpiogiess 1 @) X | JTAG Chain Configuratiors  [JTAG ready @ x
s LEs 57|  Memoy:18432|  MST2MLAB: 0/0 MAKMK: 3/125 | MAAMM144
o tigg 571 cells 18432 bits Oblocks 3blocks 0 | Hardware:
Device:
8 5| 2 SOF Manager. |:|
log: 201311/0919.57.48 #0 click o insert time bar
Type A|ia,| Hame l 24 26 28 230 232 24 25 238 20 242 %4 25 28 250 %2 254 |
o o 1 =1 1 ]
[ B GO X X2 )G X X e X7 X )8 X0 X s e X e (Ce o X X X ()
© ® tmp 300 6503 001350 TR 300 I3 13 65 LB 30 B F1 65 00 63 (3 62 €3 B 45 E0 ¢85 1 6B 0D

3-55 SignalTap [ R E#H B F

W ML 2 emp ] 3-55) 2 MA™ -+ 5 7T LR IF i A 2 £ 5 R ol ok 7
T R B SR 0 T AR . b SR UL S A L0 O 1 B £ B
JE » AT B LB A 68 0L o T B 006 1 28 £33 5 48 CH a0 9 ot B0 050 00 o 9 2
7R3 “Bus Display Format” % “Line Chart” , B} AT 4% 45 40 [4] 3-56 FF 7% fy “ 45 81 £55
A

log: 201311/08 18:57:48 #0 click to insert time bar

Type Mi“l HName 12‘A 12'5 12[5 |3I0 1%2 1:30 13]5 13|B 1!}0 10‘2 m‘n 115 NIB 15[0 15'2 15'6

[od

B Ba 0 TR 3 T3 18 3 T000 ER T &5 5 3 13 43 £3 15 5 I &5 &3 05 3 13 5 §3 § (B B ¢B EB I
= tmp

(] M

o (0] L1 011 e 01 r1 1 rL 1

< tmelt] 1 1 1 1 1 1 1

) il - )

) mp(3) — 1 1 1

3-56 SignalTap | HEHFOEEENES KR

FE: A LS B THE A TR T, SignalTap [ 69 KA aF 4 A T 40 & %
o TAERT A, BAEZFERA Y. ZHE AR IR X R REI N RA P HR
®AZT ARG AP XNE S (A THRES).

hy SignalTap [T $2 #7037 BB Y 07 156 02 78 T00Z SCPF Y S8 4R rb 35 0 — A~ B i A i 11
in*“Loge_clk: In std_logic”; 7 I SE A AN 0 0 1) 68 A 2 2 AR e 3, i #E SignalTap 1
1 200 AT DA 3EBE Loge_clk iy RAERT 4,

(7) SignalTap I (% H fth % & FAE 6 5k, DL R G405 & T 50— i A 20 3 A5 e
“onts”, HORFERTAPZ olk, F58 F AT DL B 2 A A KA B (Instance) . 7] DU AT It
T RE A a2 vh (0 B e e Sl N7 Fph LR — 0 32 48 A3 BT AU R B L O AE 22 A I AR e v
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I FH AN 7] 79 B 4 F0AS [] 1 3

Instance & 88 ARVFAE 2 A MU e b 8 57 R 44T Signal Tap 1128 8. w LAl H
‘B SignalTap I 3C £ o @ v M BR A 3R 4y 45 000 320 485 Bk, Instance 48 31 4% 1 7R 4 i
SignalTap [T 3CHH BT AT AR B | 4> A DG I 304 B 7y 224 i bR 2 A B 56 52 46 o fiff 1)
()32 48 06 2 RIAE i # FE i . I e A5 1L 28 mT LA B 4G 5 43 1 28 8 A T (U #8120k
BRI . T LLBE R 2 A8 48 2 i S % #% Run Analysis (Processing 3¢ #.) > [7] Bif
A s Z A HTL . 1A, SignalTap 1T (4 SR A filt & 5 5% 3% %8 9 50 5% 58 3 4 J7 T 19
W F R LR Bl K AR A E 2 A B DL RS i &

Al LAl SignalTap 11 % % 43 14 % 1 (% Signal Configuration [ #i 1% & filk %& #5 1
T, AT LLSA A T AR A 22 10 A i 2 28 O (8 AT LR A R O i A E . nT LA
P RE A4 A B fik e A . WL S R SE . il R E FC VR AR RE AR R R IR A e e 7E ik
e Z TR i g 22 0 IO R B RO . A BB 2 T 1 8 R A G A 40 Sk o A B I T
B 5 I A R B 1 T2 B R SR AR TR BE DT 1 48 B R

SignalTap [T 9 itk & 15 5t A SR 15 8 sl 4 8 O fioh i 42 ) 322 4 o w) AR 90 52 s 95 22 1
P HAT i

3.1.3 #AREEEIT 2-4FF

1. KIEEM

(1) #k—2L 8% Quartus || RIS RBOH T LR .
(2) FEARFAHER B A
(3) A FPGA S8 & By T RE R HI 7 1% .

2. TXWAR

FIH Quartus [l JC & R A BEA BT, Bt — 4> 2-4 30848, O AR U P e SCHE 8]
P55 o BRRAESES & b BEAT BRI, 300 2-4 PRAD 4% i DI AE .

3. RWIKE

PC 1
Quartus [[ #{FH5E &
GW48-CP++ i & 14

4. KRB 5K

A EDA T H 3547 5B P iy A Bt B9 D0 a2 - B E 3 AN BA VF 22 08 g AR B R
B 78 i 3R T 4 R UL RE TRUHE A T S8 R R ML Y B R GBI . Quartus [T ERfE T
LU B 45 11 52 3% 1) D B I g A BT D RE . [ IF A BC A5 1 B R A OE T A R A B
TC P, SRS B AR TR (AN S AR T Bl g D i 8% AR R T RE T (LA T
JUFPiA 74 2T E) USSR RIT TP A% HY S 50T 38 19 2 DI RE B LPM J . Quartus
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TR

I R B 3 7 DB PR i A 22 J2= Ok i it DR (45 0 7 RE G T S R MBI i B R e . S5
G800 80 L B SE B A LE L Quartus [T 32 At D 2 PR g A it D BE B A Al L UL O R e
PP

(D) REREATIERE W B7 R GE it . & 40 10 20 o % 50 96 3 RE 58 i3 — )2 g
Wit

(2) X RGP BIAE—JZ U BUE —TTF B DI RE REZEFTRT 8 1 F P 07 0 RS B35 0. Tns. [
VL REZR 5 b BN 2R GE PT BE " AR AN R B 55 4 B R 4L .

(3) Jd i B e 7 L B RS 07 R 2R 00 B B IR T A L O B I 21 I

(4) REXTBETH 7 58 HEAT Bl f 5 8 i A B it i o v BT A ) R R S AR

(5) @i 4 PR F 2. BE7E FPGA 8% CPLD [ #3100 H Fifi i 5 47 68 24 5 360 01E

(6) UnSRAEH] FPGA HIECE 4 F2 77 30 R A A fe F 3 R A FE A9 [ L

(7 755 BACH T BT BORRUIE . % 50 0 80 A B S0 36 ) 10 0 4 19 07 3k 58 Btk
T A Dy R 2 2] B PR EAR T LA DR U 8] A 51 A 51 4 o B P L BRI T TS
Jo K 5 £ A RLAR L2 i L AT BE 7 A ) 23 A R ORI R AEON DL F E ARA E SE )
T R

£ Quartus [1 H . AHE P 25 B8 i T LD L ] R 3 e 1T 1 2 X AR i 2 P B0 (R L
HE 121 4 1 2% 2 ZE DN REAL 4% - X Altera S 2 T BE AL B R AT 19 1 . 47 AKE P 0 5L AR BT A
o IAE 8T BAE 350 T SO b Sr SO pE. B — D HE B BT SO (Block Diagram/
Schemetic File) . RIVAT$T JT-HE P 2 45 45 o F1) FH 70 48 40 7 58 1l ri i 1) J B PRI 5T

Quartus [ HE P g 45 45 152 DO 2 B AE [RTBE 0T SCMF . HE 18] 4 B 488 o 90 5 A PRS00 SO AF
AR BT h 2 B ARE RIS 5 o M A P& 20 4 » DG — A R BT L D B ] k5 75 5
RER B2 A IR TR AT RUTE A& BOHE [ R4 5 I8 BB B2 S0P . M HAE (] 26 4
for AT LU AHE P A BE AR BROTAT 5 B A B B9 B A 5 AR BT SR DL A 9 15 5, 1K
FEN BB BB AR A . A 22 TR]R AR SR A N A 5 3 4 ¢ R A I i PR R . T
PAASCRHE BT A8 S B3t ] DU 5 H At U8R PR DT SR AR S 51 0 P it

HE 121 24 Bt 2 £ (3 AT By T A AE PRI IR0 SO v 3 2 BT R 7S B0 (A 95 G RT3
FEWLID W — 2 T H. . al LS SO P 25 48 i 1) 8 705 B 30T o 497) A AR A0 8 ) i e B 1) 4R
A ] BE A5 R 2B FMEER 46 T L B A ] 4 HE P] A SRR AR PR g 4

Quartus |1 HfF 5 Bt AT 7EHE 5] 2 55 4% b 8 ) 25 FlOoZ A D REAT 5. B4R A BT . B 4
PRI P (LPMD Bk BRI % D RERC B . it 2 T LA 5k 2632 3 T BE A 5 (OT A 1) Rk
58 WOHE BT S o B SE i it i 2 AR I RE LT . 7E Quartus [ . Jode 4 1% DL H s g X
ML NI 3-57 firan . [THBKTETTas F BB 0 S i A7 & J2 Primitives/Logic. JT a1 &
(1T HL B 24 PR B AT 5 K 3-4 7R . Hivh “ Megafunctions” i oA 35 75 DT BERE B, “ Others”
F S IUT Muxplus2 AL BEA BIT A 74 R B4 45 AT LUTEAE (813 T F S0 b il 5 28
TCaFRT S . M Quartus 11 HE 5] g5 B 4% F1 JT &% 15 2 0T LA D7 i 4 58 )l 4% b 52 2% 3% B H %

Bt
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Libraries:

H & d/alters/martusdl/1i o
EB megafunctions
PG arithmetic
embedded_logic
gates
10
storage
:B others
Cl maxplus?
i W6 opencore_plus
ElE primitives
HE buffer
R Tamia
< | >

Hame:

| o

[~ Repeat-insert mo
[” Insert symbol as bl
r

Megalizard Flug-In Manager. .. |

| Concel |

B 3-57 mEtEBRESR

R34 THEEETHITRBEREMAS

7 B % JC 2% 4 & R Altera TGRS
51 AND2
517 OR2
—
HET] NANDZ D
{11 S
—
GEdn! NOR2 D_
{112 S
JET] NOT
Skl XOR | }'_,f ;_
NS
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TR

2-4 VRO AR T A5 & 3-58 Fron , HAE R WNFE 3-5 Fis.
£35 2-4FWENEESR

T R
1A FO — ] A ) H
—IB F1— A B F3 F2 F1 FO
F2 —
F3 — 0 0 0 0 0 1
0 1 0 0 1 0
inst 1 0 0 1 0 0
. o r 1 1 1 0 0 0
B 3-58 24 FWBETHE/FS

5. IRESZSTE

1) T
TS HEST — AN SO e DB A A BT SO A T Z SR e b, i D \decoder24, T
B SR AANE RS, SO AR OR B S G AS A% . SRIFIET Quartus [ PR, BERE E
¥ i File>New Project Wizard, F| 7] 01 g Tf& . & 3-59 frn .48 TRAAHE %R
D:\decoder24., T 4% Fl 52 1A 4% A BU decoder24 . HiAth 15 8 16 391 AT LA 15 2RI . B 2 T 7%
UG P .
roject rd: Directory, Name, Top-| ntity [page

‘what iz the working directory for this project?

ID:\decoder24
‘What iz the name of this project?
Idecoder24|

‘What iz the name of the top-level design entity for this project? This name is case sensitive and must
exactly match the entity name in the design file.

Idecoderzti _]

Use Ewisting Project Settings ...

Back | Fext > I Finish I BIH ]

& 3-59 £l T 72 decoder24

2) HEE &5 A
(1) BraMER SCE AT IFHE R g 28 . HAKEIR . F 32 51 File—>New, # i} New X} i
FE . & #% Block Diagram/Schema Tic File SCFZE AL, 401 3-60 R . 58 e » BIFT I HE K 24
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Waw RN — = A RHEE SCE . RAFIZSCHF DS decoder24. bdf,

EE: XA RGET I, L 2HRE m

G A SEF XA LS A p SGFC Budr o A
(2) TG 4 122 vP 3 FH oG 4 PR A BIHE 30 | | oesn e

AHDL File
PESERRTT 24 TR B . BB TE. mHE
2B Edit—Insert Symbol 8% % B T. H £ 3% 312‘[2;‘&;',};';3.5{')}..8
S D s 1E S8 BT 1 R AT AT — A LB b A Verog HOL e

o5 BB HE S, 1 B P BB A TT T Tnsert | [o venay e

Hexadecimal (Intel-Format) File

Symbol TRAFHLIME) 361 PR II“HATLH" | i

¥FiE HE . M Megafunctions\ Arithmetic JFE i1 3% £% e T D

and2, AT LA 2L Y8 4% T A5 5 24 8K, 40 and2, BT 7 SignalTep | Logi AndyzerFie

IV HIRE AT S 4 (B h BT A pE 361 BT | SO

Symbol X§ i HE 4 A2 . S5 JF Bt Symbol % i e

HE 19 OK 43¢ 11 76 HE e S 2% i S ke WUBR 22 6 B 7T Toari e d
A TT RN S 8 T T, T L S R o LA e Eml

IMAZA 51T, W SRR B, ol L s B
Esc 8, 50 fify BUBR A B 70 95010 09 40 B o vp 8 B 3-60 SIEHEHENESER

$£ Cancle B3I AT IR H TR fr AR 47 H At 52

VEo TR BE A A 5 200 ] R %, B 1T Al % 24 PR AN % 3-4 o . SR A A/ i |
TS i A5 R4 ) R TInput” i 5 LRI Outpat” A6 A/ 1 51 BIEE ST RDE B Sk 68
JE primitives/pin, $§ 2-4 PRI ERFTTT B TCOAFS A BIHE B SO L 45 R A1l 3-62 iR .

s.

Lib

i B opencore_plus
= primitives
HET buffer
FE logic

| LEE andl?

g [P >

Hame:

[an2 fod

[V Repeat-insert mo:
e
-

Megafizard Plug-In Manager. .. |

3-61 FATERHFREZREERFS

(3) Bilikam A/ th 3 H pin_name SC540  fd 28 B 6, f B B0 0 A &5 51 44
A\B.FO.F1.F2 fl F3. wal LXUH 4 A /i i s 10455 78 31 9 Pin Properties %7 M
W4 14 R SRR A DA B AT S & HL T (Orthogonal Node Tool) Il 71
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TBHE

SUTPUT [ pin_namez

LUTPUT = pin_name3

SUTPUT  — pin_name4

LUTPUT = pin_named

2 T T 100 > &l

E3-62 HMETHHS

(Orthogonal Bus Tool) £/ HE B 45 5 3% 4 b o » BRIy vk J2 B iy ST A4 5 1 A/ o i
155 3 3l 3% 26 1 7 5 3 e 4 454> Ju . dn R 3-63 i .

B 363 HSHEREME

(4) SEIN 2-4 PRAS 252 58 i B BT S . BEBE 3 50 File— Save, R A7 HE B SCHF 2 D2\
decoder24\decoder24. bdf,

3) wnlF ik $E g

P K B Assignments — Device, X} #% 4 #f 17 B &, & £ Cyclone [l & %1
EP3C40Q240C8 #I5- . 4R 51+ F 32 B Processing—Start Compilation B{# T. H £ 19 #240
bR EE S TR AT AR, IR decoder24. bdf ) 38 B HL KA B R E R T
Processing Ab#AE 2 W oR ok . WUl B B R . A RS B A B BCIE B 1R S P R T
P BB G R

O A

(D) ATIFBOE i B 4% . BE+% £ 3 5 File—>New i, 7E New X 15 HE h & Verification/
Debugging Files #111) Vector Waveform File, Bd; OK ##4H . Bt 9125 [ B9 IR T S 3 4% .

(2) fEE3RH Edit>End Time 3, 78 5 H A0 35 4HE o i) Time #2 b A S8 i 807, 1)



141

s @zﬁﬁﬁﬂzaﬁiﬁw

O3 E D 0 100, 343 6 56 s

(3) FERLPOV A % File hiY Save As B LA4 A decoder24. vwl (BRINA) #Y 3 IE
CFAE A D \decoder24 i,

(L) W AEST M. B LR decoder24 Wi O fE ST A AW RiES T . FEFLT

Tk —. BB KB View— Utility Windows— Node Finder #% 3. 7F Node
Finder % O P2 List 34, T 2AEZLM Node Found £ B ¥ T %3+ 9 19 decoder24 T
R A um 10 51 B 2 Can 5 ok X3 35 AE P i List A 7R, 75 2 58 e 15 — Ik, Bk
Processing—Start Compilation, X J5 EE Z L) F#/EZ ). 0] DA BUbs Z2 48 28 i Node
Found #H1 #5146 5,32 decoder24. vwi Zi#H % 1T H Y Name #2,

Ik WGP g A5 22 A (Name #2) (9 25 (40, 304 X 55 A W& 3-64 TR . 7
Filter f£ f1#E#2“Pins: All” SR J5 By List %4, T2 7E 4 M Node Found £ i3 1% 11
) mux2la TR0 FT A i 1151022 CUn 2R b X 3% 4E 9 List N 5o . 75 28 3 dm i — IR,
B i% Processing—Start Compilation, %8 5 8 52 LA F#AERE#2) o I BUBR B % 1 v ) ) 4%
#l >, ¥ Node Found £ it (9 45 a5 A B 45 ] Selected Nodes 21, fiJ5 #ifi OK
FEHL L S8 LT BOE Y SRS R

Rode Finder @

Named: |" _vJ Filter: |Pins: all _vJ Customize... | List (:% oK |

Laok if: |ldecoder24] ﬂJ W Include subentities Caricel |
Nodes Found: Selected Nodes:

| Name I Assignments l Type | Creator Name { Assignments I Type I Creatar

A Unassigned  Input User entered I decoder24lt. Unassigned  Input User ente

B Unassigned  Input User entered I |decoderdB Unassigned  Input User ente

o FO Unassigned  Output User entered 4P [decoder24F0 Unassigned  Output User ente

£ F1 Unassigned  Output User entered ¥ [decoder24F1  Unassigned  Output User ente

o F2 Unassigned  Output User entered I |[decoder24F2  Unassigned  Output User ente

I F3 Unassigned  Output User entered I |decoder24F3  Unassigned  Output User ente

i
>
L
|Copy all to Selected Nodes listl

«|

B 3-64 HmMBWN/HHES

(5) G AP o Fh BT o 0 200 B9 4 B R R AL 8 42 R s, OF B oK
A /N7 L G T AR DRI g A DX s R 7 e B OO s B B o (/) i 7 A s A
TOE AL X B R A AR R E AR RO RO g FR IR 24 RIS 0 BE R
(3 3-5) Bt A B - g i dm A DO AT LUR MM %

S — ROk e M DO g AR RS B AR TR O i Sk (A AR A TR
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TR

RERIE I BAR 22t il A5 5 I BE OR 2 Name R2HE) A 55 25 5 J5 1 HY B
2D o [ J5 4 s — B, Bk rhoxk B e I8 s ) o P B O g A RS (8T 3-20) By
R PR BB B A RS O P AN AT 3-65 BT . M X R T I i BRIAT 3-66 58 AL
GACNOETE =

Master Time Bar: 21825 ns 4| +| Painter: 539.08 nz Inter
&=
% A Dps 512 us 10.24 us 15.36 us 20.48 uz 25.6 us 30.T2 us 35.84 us
Name 1;33.‘%@3 at 21 325 nsl Ll 1 1 [ Ll 1
96 Q 5 s .
O w0
w1 B
| FY) 0
)@ wx ||EF3 F1
K
5 o 4 F2
TLAGPS F3
—
\Y N
3-65 FHFEEARES
Master Time Bar: 21.825ns +| »| Pointer: 21.32us Interval: 21.3us
&
N Vilwe at PPE 512w 1020 us  15.3pus 2045 us 256w 072w 3Blus  40%us 4608w S1Pus !
Hame | o)"g3 7o [P1.825 ns
A f
o (o Iy BO
[ B BO
& w2 FO BX
=N Fl B X
Y EX F2 BX
ar |25 F3 BX
85—

3-66 2-4 FBHB[HEHBNEEE(—)

S AT AEPOE AR AR Name £2 b Bl i D55 AL 228 0 0, P 08 4% J2 50
Edit—>Value—Clock 365 , 5 # 7E 3¢ J 4 i &5 T HAS b 50 i “ i 0 5573 £ (18] 3-20) 75
H i Clock i 1 rp 5 B 0 4 8 10ps; Clock % H 1) Duty Cycle f& 4 55 [, A % £
“507, B 5096 5 A5 L5 [RIRE T B B E S I E S B A 20ps 55 A I B I1E S R P RS
KA VXHESBES A M B K4 FMALEH O & 3-67 .

@ Master Time Bar: 17.811158 us 4| *| Pointer: 3412 us Interval:
% i TR pPs = l? us 10. 2[4 us 15. SiE‘T \1851115820. 4[8 us 25.§ us 30. T; us T 8|4 us 40,9IE
A 17.81 us . Lo
5 (w0 A B 1
@\ w1 B B 1
o2 FO BEX
O (@3 F1 B
4 04 F2 B X
o €¥ S F3 B X
&l

3-67 24 FBHEHBHEBNEEE(D)

(6) BalffEA. AR E Y, 7 E# F X 8 Processing—Start Simulation, 8¢ 3 £
7 Quartus II T B2 A (o 4% 4. JF 8505 B, B 2 B Simulator Was Successful, fjj &

45

o
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(7)) M BE5 8. 05 H )% B CF Simulation Waveforms % 3 & < H a3 i, 40
& 3-68 Fin . ANARAS/NG KM T Simulation Waveforms % 1, 7] DL EE B gl 05 B 45 . sl &
PEFE 33K 1 Processing—Simulation Report., T H- 5 BB # & C#F . 1 2, Quartus 11 1Y
T BWIE ST BOE S SCPECx L vwD 5308 07 B4l 5 SCHF (Simulation Report) j2& 43 JF
1. WERTEE 8 i 5 (Processing—Run Simulation) J5 , I & A 1 8L H 56 BUS 09 38 &
T & B 52 “Can’ t Open Simulation Report Window , "{H g 545 B3, WA B & 47 715
HIE A, 26 £ 3E B Processing—Simulation Report,

k Master Time Bar: 17.811158 us 4| »| Pointer: 62.96 us Interval:
A D ps 5.12 us 10.24 us 15.36 us 20.48 us 25.6 us 30.72 us 35.84 us 40.96 v
Wil f T i | " i i i 1
% Hame 17.81 us 17.811158 us
]

Q 0 A B 1

w1 B BE1

P2 FO BEO
#h €L 3 F1 EO
A, e 2 B0
— |5 F3 B 1 | T 1 1 | N
oo,
=g

3-68 24 EFMHBHELER

B S W87 i3 1128 | AR T AT i LT 1 5 S 5 A S 2 | A o B e s el = T D O
Simulation Waveforms & F Ze ] T HA% /R 46 /0" 1l & RUARTEBOE b 42 s it
sl A R X I BEAT O AN AG /s o A SR R T OR s /N AT DA T B At
W IV G B8 1 10 PP AR AR 7 B L 3 B PR B AR B 1 B9 Zoom T, A IR A R B SR R BE B Fit
in Window, 45 B 45 /1N i I8 AN B8 s vl B8 09 42 B D 8, 7T g S 1 B0 A (8] K 8, 2 % i
AT A 19 15 7 ) (] X3, 14 A B 0 LB ]

5) FIJH RTL W88 & F 45 G J5 1 i 14

Quartus I o] 52 B AE 4 i 38 it & o M 3% 3CfF (VHDL, Verilog, BDF . TDF | EDIF,
VQM) X I RTL A i, ik T .

WPE F 3 B File— Open, 3T JF TR Fr 75 B % T 19 decoder24. bdf % 3 £ Project
Navigator % H # Files T2 i 1 W il decoder24. bdf, iE#f £ B Tools— Netlist Viewer—
RTL Viewer 3, o] LLFT I 2-4 Fef 4 TR 4 2 RTL H B &L a8l 3-69 fras. X &l
T A e, Bl A ) 4 00, T B R T i 45 R R

inst6

B L R e N

6) BIMISIsE S Sof i T 2

PEHERE No. 5.2 00 2. 3. 4 (05 403 (3 2-14) . sty
B 2-4 P2 I3 BIGE 7R MG £ 3-6. £F Quartus b
11 . 348 E 3624 Assignment—>Pin 35, 6 # H 6 1 instd
A5 2-4 VR T 58 45 A 5 5 0 BRI R B 0 51 1 4 1 32 ) D=
Node Name Fll Location H1, 5¢ il B, AU 51 8 2 . SR )
0 Location 1T BIZ7% 3. 1.1 5T 1M S

Location %1, 5| |4 & 5¢ 54 5 » £ % 325K 2 Processing—
Start Compilation, Zf 584 T 42, & 3-69 2-4 iFFBEE RTL fEKE
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TEHIE

SRIG R BUE 4GEH: GWAS-CP++ LI & 51t AL T Ll G ik, REEHE 3%
P4 Tools — Programmer, 1 £ 4 £2 J7 3\ “ByteBlasterMV [ LPT1 |7, F # Sof 3¢ {4 3|
GW48-CP++ &5, KT 5 57% 3.3, 1 1P g B 9K

TESCIR & bl ik 45 1A 2 f A B I EE LED T 089 8 /s 58 i 2-4 PRA% 2% 19 2 BE
B TE SR 2-4 PR AR A/ A 2Rt Se g 45 R A L R PR S e B R AT LA
=2

F 36 2-4iFWMBESIMPEARR

WA/ BHIES % & 51 B & R 5l WS
A e 1
B etk 2
F3 LED 4T 4
F2 LED 4T 3
F1 LED 4T 2
Fo LED 4T 1

3.1.4 Altera TS EZ= N REHE IR

1. XWEM

(D) #—23K Quartus [ FFAMBERBE AR,
(2) A0 HAE B &t A .
(3) & FPGA L5 & T g Al FH ik .

2. IBWAF

FIAH Quartus [ HE & 4 55 2% # 57 B T4 A SCHF 3l A Altera JT#§ 14 12 b (1) 72 T B A
lpm_counter GHEU#R) » I X HAEATECE . T ## lpm_counter 1) TAE P,

3. KWIREE

PC 186
Quartus || ZH4HEE 1 &
GW48-CP++ L & 14

4. KRB 5K

Quartus [ AMUAEHE T HABEH TR AN ST Rl & D fill & #5535 L 2 D g oo
& TILPFIA 74 200 EE 0524t 7 28000 &8 1) 2 D ag e LPM e, A1 HIHE &l J
gy, 0] LIXT Altera $243t 14 722 T BEAR B 9E 47 41 4k, B FH Megawizard Plug-In Manager(Tools
SR W] DL S B8 B & 2 D REAE R ) SCAR B PR T SO . X B 7 S D) R AR B AR
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BT Altera 249G LPM ZhBEAE N I 22 THRERC B, 22 Th RE A B DIUAE & B8 1 SC 4
FIRE I i o A Quartus [T HE ] 2 i 25 1122 D BEA B T LA 5 (o iy 5% B 4% Fh 52 2% 32 4 ol I
wit,

ZINFEEH Ipm_counter J&— 11 H i f i, HAE B 40 3-70 fiR . lpm_counter £5
IF 4 HfES.

clock——%i A B g ik ol
Ipm counter(
datal 7..0 ]|——Ilpm_counter {% 6 {37 Z 35 i . up counter
— data[7..0
a[7..0]—Ipm_counter ) 8 R §UHE 4 3 el g0~
acle—— SRS L TA R, —pelock = &
aload——S 00 #5038 15 5, aload J2& 3+ 5 4% # l %, 24 inst [ ]

aload My HL RS, 7B 4 T 147 B EOR A, B qL7..0 4 H
datal 7..0JRYEHE . Y4 aload MK HLSEHF . TH B AL T BUR S .
BB R clock TR IR . o[ 7..0 JB9ME A 3 1.

& 3-70 lpm_counter 1E &

5. XBRESZSESTR

D s T

TSN — A SO I DR BT A BT SO A T % SO e L T D\ count, 3B 4T
Quartus I 4, &4 335 5 File>New Project Wizard, # i o] T @] & T. 7. 48 & TRAF
JiCH 5% 4 D:\count, T2 FISLAK A FTHL count, A & e 1 A] LULR 47 BRAME B 2 T2
PUE i .

2) HEP B A

(1) 7 EAE SO T T HE BT g 48 4 . BB B . F2 38 5 File—>New, 3 i1 New X 3%
HE , % #% Block Diagram/Schema Tic File SCFEEAY, S8 5 » BIFT FFAE (5] 9 48 25 I A2 i —
A P RE P SCAF . (77 0P count. b,

FE: A T RGRIT IR SRR RS — R,

(2) WICHFRE i A —A> 8 Arit$as . AR PR 4% 3238 # Edit—>Insert Symbol 5{#
BT H R F i O . A Megafunctions\ Arithmetic J&E F7 3% #% Ipm_counter, 41K 3-71 fF
Ne i OK 24 )5 . 1 B megawizard Plug-In Manager #d H . 2 F &% B 588 10 S8
8 L CBRIA ), 388 18 CERINMED . % 22 B0 i JL IR Next %4, & 2 8L A & & 0 1 4o
Kl 3-72 s, EHERAIEEMERGES . &5 5 d Finish #4815 42 i lpm_counter 45,
lpm_counter X f VHDL SCHARFE SRR X4 4 D: \count\lpm_counter0 (ERIAED .
SR F Ipm_counter AITA BIHE [&] Zi 5 %5 25 H BY count. bdf U,

(3) #RJ5 N Ipm_counter B A /i th 5| I %0 A 5144 FR 2 Input, B 351 1A% 5
Output, I 7ETC A R th A8y . ] DLUFE o 0B 4% b A AT 5 24 F% 40 Input, W B 75 HE & 455
SHSH ., AT R RS 71 (Orthogonal Node Tool) fl "]
(Orthogonal Bus Tool) ¥ Ipm_counter )£ HE B £F 5 3% F2 0 K , 5€ B2 58 e B3

EE: B4 E125 Datal7..0]4 Q[7..0]%F % A "1 (Orthogonal Bus Tool) 5 #ir X/ #r i
F1 ik L Bp R OMLER T 5 AN/ B 5] e AR i

(4) ¥ F 3 File—>Save, 173X D:\count\count. bdf,
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Libraries:

altmult_accum ~
altrult_add
altmult_complex e .
divide .- i
Ipm_abs - - LPM _COUNTER
lpm_add_sub s .
'« |pm_compare : X seet
sload
:pm‘div:de . & updown
lprn_rnult 1Ml : :
parallel_add : Zr;t;;n
EE gates -
POLEE busmux 5
iy Ipm_and b
< >
Name:

Ipm_counter J .

V' Repeatinsert mode

[ Insert symbol as block
¥ Launch Megaw/izard Plug-in

Megawizard Plug-In Manager... |

0K | Cancel |

3-71 #HN lpm_counter JT 4

Nega¥Wizard Plug-In Nanager — LPE_COUNTER [page 3 of 5] E]‘:‘g]

Documentation

lpm_counterd Da you want any optional inputs?

up countel
data[7..0] o701 Synchronous inputs Asynchronous inputs
o [ Clear ¥ Clear
[ Load

[] Set [] Set

Resource Usage
8 lut + 16 mux21 + 8 reg|

I Cancel " < Back || Next » “ Einish |

B 3-72 iZ & lpm_counter i N\

3) wRfFEERE O

P FE P Assignments—Device, ] #% /4 17L& , #£ 8 Cyclone [l %1 EP3C40Q240C8
W5, E$E T B Processing—Start Compilation 8¢ T B A2 7 E » , X4 A TR 35 1T ik
T, T B File—New I, 7 New % 0 H 36 Verification/Debugging Files H1 A
Vector Waveform File, & 37 3¢ I 3044,

O i K

(1) #EF 3§ View—Utility Windows—Node Finder 3£, % count 1944 A /i
AR S IMA R e ar . BAKITEZS% 3.3, 1 Wby fy 5 ar .
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EFE: mE AT datal 7.0 qL7..0]BmAE T, TARA 5 A m A datal 7],
data[6]"“ ’data[oj7q[7]’q[6]"" 9q[ojy’ﬁﬂ@ 3-73 ﬁﬁ—ﬁ:o

Node Finder @

Named: [+ | Fiter: [Pins: all ~l Custorize... List I % |
Look in: J _l IV Include subentities Cancel
Nodes Found: Selected Nodes:
Name i Assignments I Type | Creator A~
9 clock Unassigned  Input User entere [COUNTIclock  Unassigned  Input
D data Unassigned  Input Group  User entere ¥ ICOUNTIdata Unassigned  Input Group  Usere
9" data[0] Unassigned  Input User entere 7 ICOUNTIq Unassigned  Output Gro...  Usere
9" data[1]  Unassigned  Input User entere 9 [COUNTIscl Unassigned  Input Usere
9 data[2] Unassigned  Input User entere ICOUNTIsload ~ Unassigned  Input User,
9 data[3] Unassigned  Input User entere
9 data[4] Unassigned  Input User entere #I
9 data[5] Unassigned  Input User entere.
9 data[8] Unassigned  Input User entere ﬂ
19 data[7]  Unassigned  Input User entere.
Dq Unassigned  Output Gr...  User entere _<,
o 0] Unassigned  Output User entere ﬂ
- q1] Unassigned  Output User entere.
A q[2] Unassigned  Output User entere.
o q3] Unassigned  Output User entere.
L 4] Unassigned  Output User entere.
P q[5] Unassigned  Output User entere
P q[6] Unassigned  Output User entere
P q[7] Unassigned  Output User entere v
< > < >

3-73  MMNEN /5B B E

(2) dmii APIY . Bl 08 6 0 22 M0~ 4 Bt on " He B 42 bR R L O Bl ROR
A /N OO T L AR G DR SRR e i B OO ECA B Bt (A /) A A A Ak
TIE YA, X I ECI A AR bR E TR T IR B 9, 4% ] count (Y H(H R X 1A
WV, ¥E$E £ 38 B8 Processing—Start Simulation, 3% # M. Quartus [ T.HE: By = 424,
FE4E 05 B A5 BRI 5 5 T8 R TR count A BT an &l 3-74 fis . b R A T
ﬁiﬁ%ﬂ‘]ﬁiﬁmﬁ O L 5 BRI B e L B load AT data % A i 19 R
TR IR E T B R IR R S o

% Master Time Bar: 243 ns +| »| Painter: 1812 us Interval:
A e Ee o= 10.24 us 20,48 us 30.72 us 40.96 us 51.2 us B1.44 us
' Name 24.3 ns P43 ns
i
& w0 clock BO [ 1 1 |
o1 data B 00000000
> 10 aclr BO 1
#h w11 aload BO
@4 o1z q B OOCOOO 00000001 ¥ 00000010 00000011 ¥ 00000100 3 00000101 ¥ 00000110 )
=
nn.

3-74 HEFITE count WITE K

5 FIBIE Y Sof XM T

PEPEALEC No. 5.2 18 3. 1. 1 1 5| IIBUE I7 v » B F i 40As T/ count /95| A BIE 75 %
B 3-7, fE Quartus || H . 28 F 5 Assignment—Pin. 725U A5 H A R8sy T
2 count % MF T4 %%ﬂﬁﬂ\“ﬁ’ﬂplﬂﬁﬂ%ﬁ}%ﬂiﬁiﬂ Node Name #l Location 1 »%’:ﬁi%ﬂ%ﬂ"]?l
HaiE . 5l HBiEsEE )T, 8 F 52 B Processing— Start Compilation, i FFE N T2, 4R
Jo ik ESE Tools»Programmer,Tﬁ Sof 5] GW48-CP++ L8 & . AESL K & L, I
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TBHE

TR B T RE - 10 e il H ARl SE R A R A (R AR OF R S B B R AT LU

H—2.
®3T 24 FWBIMBEATRR
WN/BHES 5p & 5| B & 51 B S

clk Clock0
data[ 7] Fri 2
datal 6] Fiek 2
data[ 5] Tk 2
datal[ 4] Feid 2
data[ 3] 1
datal 2] T 1
data[ 1] 1
datal 0] Fkd 1
aload g i
aclr g !

o 7] LED 4T 7
o [6] LED 4T 6
o (5] LED 4T 5
ql[4] LED 4T 4
03] LED 4T 3
al2] LED 47T 2
qll] LED ] 1
ql0] LED 4T 20

EE: A#ELEEGWISCPH+HER S5 EMN. A EREB R, FLEFES
2 7 X 4 ByteBlasterMV[LPT1 ], B4k 5 EA £ 3. 1.1 P& BHEEH S5,

3.1.0 wHRHEBEEXEREA

1. XWAM

(D) #—2E8%K Quartus [ FFAMBEMEIH A FRE.
(2) FE4E R FHAE B BT A

(3) #4& FPGA S5 & K DM 77 i

2. TXWAR

(1) B2 Quartus [l JTTAFFFPEH Y 74273 T A7 fw 19 2 B D BEFN AP, A2 W 7 A 8 X

HE & 455

(2) R R (24 PR a0 74273 547 fn Bot— A 509 22 8 R L HEAT PR DT

IESLE & IR A5 R

3. RWIKE

PC
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Quartus I AR ES 1 &
GWA48-CP++Zin & 14

4. NHFEIPSHEK

£ Quartus [l H1, JC#F 1 P Others H TN Muxplus2 6L & FEABLITHI 74 R &5
PR35 T LLAEHE B T SO b il Sk S e 38 445 5 . I Quartas 11 AE B 4 58 #58 #1028 14
JE T L {5 b 52 S 4% Al A A B R R R T . AR R R B AR AE AR TA273 S LR H I A AT
LT LVEAT 8 s . HAE A 3-75 FroR . ARSEE A H AR B M 74273 AN, A
B i A ity T S A A e A 11 L AR S AR R B LTRSS AR 3-76 IR .

7y Fa
— DI QI
— D2 Q2
— D3 Q3
— D4 Q4—
— D5 Q5
— D6 Q61— 273
1> Q71— —D[7.0] Q[7.0]{—
b8 Q8= — CLK
— CLRN
— CLK .
inst] OCTALD-FF inst
B 3-75 74273 THHE E 3-76 XK 74273 THES

5. XBREZSESTR

1) gy TR

TSN — A SO e, DU R BT A B3 SO A i T S e b, i De\lab0, 3B 47
Quartus [[ B,k $E FE K 8 File—>New Project Wizard, f| [ S8 E T, 8&E TEF
Jit H 5 D:\lab0, T2 45 FISE R 4 AT lab0 . HoAth 15 ¥ 0 100 ] DA PR 5 3R A 8 T 72 LA
JEHiRE,

2) EE I A

(1) B A B SO AT T HE R S . BB BR . 3 4% 38 5 File—>New, 5 11} New Xf
T HE , #E#% Block Diagram/Schema Tic File SCAEZEAY . 58 W5 - BV T FFAE (5] g5 48 25 I A2 B
— A FRE B SO . AR AFIZ SR 1abO. bdf

EE: ZXHFEH IR E I AL RE RS -,

(2) oot A ST I Re AN A= T P A HE B 5

FH P A] DLAE PR vh oo 8 0 il E 18 T A 0 32 58 D0 BE A A LA JAT 5 75 X1 T P e L
Tl AR B P E LR HEEI AT 5 . 7E 1lab0. bdf SCFEhfi A Others\Muxplus2 Fg (1) 75 ££ 2%
JCf 74273, SRJE X 74273 HEEIAF S L 4T IF 74273, bdf SCfF (Read Only) . 4R J5 1T LAE 2L
74273 B EE L L BT B A 74273 BA A 8 i A G A — > 8 AL 5]
. GniEl 3-77 R . Gl A BESE T Y Properties S FLIGUAT DL A AE B A5 1Y 44 FR
SERUG 74273, bdf BAE K D:\1ab0\273. bdf, F|H Create/Update iy 44 i 273. bsf
. ¥ 273 STARAF S A lab0. bdf SCHFH K JER Y 74273 455 M B . # BRIET 3-78 S8 WAy
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D[0] Q[0]
BFF AT
- D[1] PgN Q[1]
> n <
D[2]1 Q2]
O e = L2 N
D3] Q[3]
oi41 Q4]
FF
Dis] PRN ais]
a
CLRN
4.5
P A
FF
o) gl | o
> [ 1]
CLRN
13 o
- |
FF
DI71 PRN Q71
a
>
CLRN
2.5

3-77 1EMIEH 273 BB K E
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o B AR A L 2 R

3) TeF e S i

0.0 Q[7.0]

& 3-78 273 LI HIEE

PR K B Assignments — Device, X} @5 4 ¥ 17 B¢ &, #% £ Cyclone [l & %1

EP3C40Q240C8 = |

e F S H Processing— Start Compilation B¢ T. H &2 40 » , X}

AT AT, 1 $E 328 File—>New, 78 New X i HE 1 2 £% Other Files H1 1
Vector Waveform File, @ 37 4f B I IE C4F . vwh) , 36 $E F 52 B View— Utility Windows—
Node Finder 3. 1 1ab0 1) 4 M5 A/ 5 5 I A 51900 4 B 3. 2% 6 & 4
Processing—Start Simulation, B .t Quartus [[ T EA2 F1Y & 7461, FFIGUT E. {f HEK .
@B E Dy 00000011, clk F TFHFAS . Q 4 i g 000000011, % 47 7% 273 STBL T 747 44t
BISHE s D data 7RI 6 74 s Q 07 FRA L 40 BT 47 58 273 9 T A o

R38 FER/2IISIMBERRE

BN/ BHES & 5l M & #R 5l B =
clk Clock0
D[7] i 2
D[6] e 2
D[5] iz 2
D[4] i 2
D[3] gk 1
D[2] /g
D[1] g
DL0] Fe 1
Ql7] LED 4T 7
Q[6] LED 4T 6
Q[5] LED 4T 5
Q[4] LED 4T 4
Q[3] LED 4T 3
Q[2] LED 4T 2
Q[1] LED 4T 1
QLo LED 4J 0
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4) | 8iE 5 Sof U T £

HEFEALK No. 0, 2 B 5| I 8iE 3R Bt a7 77 4% 273 51 I BiE Jr 8, 5 3k 3-8, 1
Quartus [ 7, 4 T35 Assignment—Pin, 7E58 1 1 &1 1 b 27 77 8 273 & ME 5 A0
FIXH 19 5112 40 BB 5] Node Name F Location 1. 52 i B B0 51 I . 5118 52
KOS, & £ 3E # Processing—Start Compilation, g P3N TR, R51EE F 3£ 8 Tools—
Programmer, F# Sof (5] GW4S-CP++ S5 & SEL I G b, 58 BUF A7 4% 273 1Y I RE I
B ISR A A A 273 H A/ A5 A R S A5 RO ) A R T S e B R AT A
2.

EE: AREZEEGWIS SR s EH AN IR FER SRR, FRLAFRES X
# “ByteBlasterMV[LPT1]” , Bk F kA F 2.5 1 PER T HE DFPLEBEHRBEHR 5. A F
e b, AdmgmARE AERHDETNL TR ORI RIEIE, LAKRIETE. A B
Bl A2 ED[7..0], 45034 3L FHE 213 -V EABBEHLT . AEE DA
Fl, AXD.&AXBE MR =, MK 273 6976k,

3.1.6 MAEEBEBERRHFTERZIT 1 LEMF

1. XWEM

(D) #—2P B Quartus [l FFRIFE MBI L.

(2) FIE MK Quartus [ FRAFJ5 BB BT HL B 00 7 1
(3) %48 Quartus [[ AW JZ AT 7 B AP 3R

(1) 7% FPGA L5 & T sE A F 7 ik .

2. XBWAE

)P B P A Ak B R AR DT ¥R BT — L A B s 58 BUBR U B JF AR FPGA 9286 &5
R UESC R AR .

3. KWIRE

PC 16
Quartus I #/F#5% 1E
GW48-CP++ 52 & 14

4. NHHEITPSHEK

fE Quartus [ H, AT DR 2 RGBT AT mgsopr— | soka
TR B, T2 SR AT DL & 24K 2 B i i

B, R AR B 379 fiok. Rtk | ss | | swke | | spp |
VRO JE R B AL A TR . Bk — 1
R R LR A ey | SE | | sE | [ G

M B /N B B S B, B A SEAR R AT LLE R 2 B 379 EBhigiHr=E
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S ) — AR BT BB AT LR A VHDL 85 fE B AL Tt . ot E M
6 10 S B AR EOT A AT LA AN [ B SEAR SR AT Z2 O . oo S T T B R AR
i, JF AR B A A AL, B TR ]

AL 2 2] fe] SR 2 A ik n s o — 604 nas w] LU PRS2 2% 22—
BT 2 T PRI R 1 S 8 R N AR B BTt . SRS TE T0UZ 52 AR B 1 S b R TS
e e TR AN gs . RIS TS W 20 1.5 W 2-6. e m AR i T A S I
2.1.5 WA 2-7, T T A 2B A 58 U el E AR D7 B AT I #% h_adder SR T4
#% f adder,

5. XIBREZSETR

T TR 2 P B R A 8 T s R AT I 2 T R B AR A B 2P R B
ABEEPEAERIES I 3. 101 AR 3. 1.3 WIS IR

D @ T

B E S — A3k de 1 D \adder, TRE4 ISR 4 7T B adder,

2) HEE B A

(1) B g HE &I SCF. e % £ 38 B File—> New, 7E 5t 19 New X 3% HE i £ # Device
Design Files T [ J& 3 18] 3¢ 4 4 %8 %y A 31 Block Diagram/Schematic File, By OK #%4H 5
KT TT I 2] g e 2 T

(2) e O o BT — DAL E A R B DRAE S5 B0, e 5 L vh 9 B AL o 1
Insert Symbol, ¥ i} “ JLE 47 X 3G HE , JA Libraries\Primitives\Logic I Libraries\Primitives
\Pin T EEIEA T o A A g L. S8 B2 s L L A 3-80 BT

B 3-80 FmEFEFEEE

(3) HEPEE R File>Save As, S H 0 &7 19 T8 H 5% D:\adder, ¥ & & 1 47 19 J 2
B SO S h_adder. bdf (73 22 BRI BY J5 28 52, bdf, U 44 24 h_adder) , 47 8 78 it SO
T,

3) Bt 3 AT I A e

KT AR A AR P T2 B 0K DL BB A i h_adder. bdf &% & A% AT E Y
Jef . FEFTIFE 0 %% SR B PR S h_adder. bdf B BT 28 $% 32 38 8 File 1 Create/
Update—Create Symbol Files For Current File I, B A] ¥ 24 /i 344 h_adder. bdf 28 g — >
JCHFAE 5 A7 B IR TE R 2 i A

4) B4 N a2 S

R T ST A N 0 TS S 0 AP T — A D B R g A L Rk [ B PR B
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3 File>New JF K SC4- g %5 % A i Block Diagram/Schematic File,
TEHT AT IT B J5 23 S 4 80 0 00t o 76 580 1 A9 77 0 rp i 4% h_adder. bdf o i 76 19 B 42
D:\adder, & i To 4, 7 42 45 4 s v (& 3-81) .,

100> @

E 3-81 =mR/FEREE

DA f_adder. bdf 24 ¥ i 4> Jin 2% ¥ 3+ 47 7€ D \adder B 3CHFJe b, 32 30 B Dy T2 2
f_adder BTIUJZ SEASCIF.

5) G i E

PP F ¥ . Assignments — Device, Xf #% 14 #F 17 Bt &, ¥ # Cyclone [ & %
EP3C40Q240C8 A5, ¥+ F 3 M1 Processing— Start Compilation =i # 7 T H A2 # £
b TR T AR AT 9 1E . 3 £ 3R # File— New i, 7 New X iE HE H 26 $% Other
Files 1 /) Vector Waveform File, & 37 ffj £ % JE SC#F (. vwh) , ¥ # F 3¢ 51 View — Utility
Windows~Node Finder ¥, # adder % 3551 A /4 H1 £ 5 00 A 80000 58 85 . pe &
JE 8 Processing—Start Simulation, 3 # #if; Quartus [| T HAL F A4 5| H 41 FF 46 0 2L 0
BLRL R S A0 2% TR {_adder 1045 ELBOE WA 3-82 TR

. Pps S170s 1024w 538w 045us 2PBfus 0P e B VW B0
A IS s
u
T |
L bin I = O
[ ! AN EENEENE!
E Fan |
2 sun | | | !

3-82 £ iEE T h adder WIHFERF

6) SIS Sof XM T #

PEFEREC No. 5. Z 5| 8w £, &t & m e sl M sie 72, M5 % 39, 1
Quartus [I o7, % #3355 Assignment—Pin, 765 1 (9 %7 1 0 2 N85 45 15 5 2 PO
N B 51 543 513581 Node Name Fl Location Ht, 58 B B 9 51 B . 51 B 2 e )
P HE I 5% B Processing — Start Compilation, 4 PF 2 4> T # . SR )5 %6 £ = 3¢ B8 Tools—
Programmer. F#{ Sof (/3] GW4S-CP++ 556 5 76 S B 5 b ol oo Je 8 1 400 2 g
3 A SIS S LED AT /9 2 7R » 56 LA N 2% 9 D) B8 I3 . 1o S A A/ it 45 2R, th S0 e
SER G0 B R IR S Es R AT R R S —

R AHBELREEGVS EREE5HEMN. FHFAETRERE, FELAEFHET X
2 “ByteBlasterMV[ILPT1]”, B4k ik A% 3.3. 1 T P B HAZE 3o,
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®39 EmMBSIMYUES R

BWN/BHES ap 15:4 51 B & &R 51 WS
ain R PIOO
bin Tk 2 PIO1
cin Jie i 3 PI1IO2
cout LED 4] 1 PIO8
sum LED /T 2 PIO9

3.1.7 Quartus THIREWMANEEXLIZIT

1. LLEMW

(1) #—B 8K Quartus [ JF & B MBI IF L FE .

(2) FEHR A Quartus [ FAFAYIE G AR THECT U  J7 5
(3) #4& Quartus [ B2 R A BT AL TR

(4) IR HFAEK Quartus [ ARBTG5 7 2 LACT 8
(5) K FPGA 5256 & WDy e Al H 7 v .

2. IWAHAE

FIF 2 38 1 vEFAS (I 3. 1.1 95) . 2-4 25 (UL 3. 1.3 45) 3HEe 88 (L 3. 1.4 F5) A
74273 FAFA (UL 3. 1.5 99 R B R AL BT 7 B B it — A a7 B A0 22 8 H i R A 2-4 3%
g o M FE R 4 A 74273 FFAEAS TAE . FFAEan B3 A PR TR . AT DL 42238 o g A\ g I
BERG IR T LORIR T ECas 0 il . FFAEAR A AR 2 3B 1 AR . o8 U
FAESLE G LIRS A5 R .

3. KWINE

PC 14
Quartus [[ # A5 1 &
GW48-CP++5280 & 14

4. LIHHEIFSHEEK

& Quartus || H 807 RGER AR AL BT AT LR A (0 I 2 PR B 7 i 3 1 5 R i
THAL B JCAR A Others HSRIU T Muxplus2 JE i 6 & SEAR BLICHN 74 R 8148 4455 0] DLAE
HE BT SCF X 2e ST 8 A5 . FIHT Quartus 11 HE 1] G 48 25 F1 0T #4422 7T LA 5 i
SE A P A 2 12 B L B T

5. XBRESZSESTR

1) #yy T
B AL — A SO e LIAE K BT AT BEE SO AR Tz e v, i D\ labl, 38 17
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Quartus [[ . E#E E32 8 File—>New Project Wizard, #|H S0 # T, 82 TEF
JCH 5 Da\labl, TAR A FIYAR A T labl o HAl 5 8 28 5507 LA AR S5 BN, B TR L
JE PR . N A R TR 2 A Ok AR HE R A B T

2) HEFBLITF A

(D AP AE SCERIFFS . 7058 2 38 1 3EPede (UL 3.3, 1 795) . 2-4 PR AR (L 3. 1.3
)R 273 W AF AR A S0 mux21a. vhd decoder24. bdf.273. bdf & %] labl SCf4 3% .

FTIF mux2la. vhd, 3% £t £ 3£ 5 File #7 i) Create/Update— Create Symbol Files For
Current File I , B A1 24 5 S mux21a. bdf 28 i — DI04 255, B mux2la. bsf 304, L)
FHESE R EM. [FBE, 4 decoder24, bsf #1 273. bsf,

(2) g7 T2 52k SC k. 36 % 28 ¥ File > New, #f it New X 3% #E , % # Block
Diagram/Schema Tic File SCH2EH , 58 iU » BV T I HE B 4 5 2%, OF A2 B — > =5 H B9 HE &
S ARAF A Tabl. bdf,

R A T RGERIT A R SRR RS — R,

FTIF labl. bdf, Hif; 33 51 Edit—>Insert Symbol (3% By THA Fpydcdl O 7eoolf
£ # mux21a.decoder24.273 Flit4#s lpm_counter &5 Ju 4, 35 B S 06 Py 25 B 5R % 11 HL 1%,
WK 3-83 iR, FEARDIGE: 4 DA 2-4 BRI E8 JE AT B8R . FF 17 25 f A B00E il i s
i LR E

Ipm_counte

Eglelarada00 >4

< 7 © [0

1 e G )

& 3-83 ZiEHKE
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